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L était écrit que la fête ne durerait 
pas !  L’avènement d’internet d’abord, 
de l’expression libre ensuite puis l’ac-

célération des échanges d’informations, de 
fichiers musicaux et d’œuvres protégées, et 
pour finir l’arrivée d’un modèle économique 
qui n’en est pas un aux yeux des barons 
du capitalisme ordinaire (avec la montée en 
puissance des logiciels libres et open-sour-
ce) ne pouvaient que susciter une levée de 
boucliers. Et une réaction radicale. 

Après avoir tenté de légiférer sur la pro-
priété intellectuelle des logiciels, initiative 
qui aurait conduit à la mort du logiciel libre 
(but évidemment recherché), voici que par 
une méthode détournée, les parlementaires 
français pourraient bien arriver au même 
résultat. 

Le projet de loi DADVSI (Droits d’Auteurs 
et Droits Voisins dans la Société de l’Infor-
mation) qui sera peut être votée à l’heure 
où vous lirez ces lignes (signature program-
mée les 22 et 23 décembre), est la transpo-
sition française d’une directive européenne 
qui consiste à limiter la diffusion d’œuvres 
numériques non protégées.

Un amendement pousserait même la 
plaisanterie jusqu’à ce que « tout éditeur 

de programmes n’ayant 
pas pris les mesures pour, 
en l’état de la technique, 
préserver les œuvres et 
les objets contre un usage 
non autorisé » pourrait 
se voir poursuivi... pour 
contrefaçon.

Dans la pratique, cette 
loi pousse à généraliser à 
tout produit numérique les 
techniques anticopie telles 
que le système des DRM 
(appliqué par Apple sur 
l’iTunes Music Store). Non 
seulement les DRM per-
mettent de limiter l’usage 
d’un même fichier, mais elles permettent 
aussi de suivre le fichier à la trace.  « Mais 
pour les géants du logiciel, l’intérêt est tout 
autre. Il s’agit, pour Microsoft ou Apple, 
d’accroître leur contrôle sur les formats des 
fichiers informatiques et les outils logiciels 
de lecture. Et, également, d’exclure les logi-
ciels libres ou non commerciaux du champ 
de la concurrence », écrit Stéphane Foucart 
dans un article paru le 22 novembre dans le 
quotidien « Le Monde ».

« Proposer des logiciels libres permet-
tant d’accéder à la culture est en passe de 
devenir un délit de contrefaçon », insiste 
le site FSF France. Si l’on peut juger nor-
mal que les auteurs et éditeurs cherchent 
à protéger leur production (et nous som-
mes de ceux-là), nous sommes en revanche 
très inquiets à l’idée que de tels systèmes 
de protection puissent empêcher l’utilisa-

tion de logiciels libres pour le multimédia, 
ou encore la diffusion radiophonique via 
internet (webradios), ou autre. Cette dis-
position pourrait d’ailleurs poser de sérieux 
problèmes à ceux-là même qui cherchent 
à imposer leur loi. Apple a posé les fonda-
tions de son système d’exploitation sur du 
code libre, le code open-source du lecteur 
multimédia VLC est abondamment exploité 
par des lecteurs de sociétés commerciales 
(Free, par exemple), le code Lame pour 
encoder le MP3 est utilisé par Sony, etc. Il 
est clair que nous sommes à un tournant. 
La reprise en main des libertés offertes par 
l’informatique et internet est en cours. C’est 
une bonne nouvelle !  Dégoûtés, nous allons 
êtres contraints d’abandonner notre drogue 
informatique pour nous adonner aux joies 
simples du jardinage ou à la construction 
de pyramides en allumettes. Bref, des plai-
sirs sains pour l’esprit.

i

Les députés seront-ils sensibles au charme de ces dames ?

http://eucd.info/
www.fsffrance.org/news/article2005-11-25.fr.html

http://www.lemonde.fr/web/article/0,1-0@2-651865,36-712288@51-698751,0.html
www.lagrosseradio.com/webradio/

http://musique-libre.org/article.php?sid=308
http://antidrm.free.fr/

FREEWARES AVM    p. 36 à 40

X11     pages 41 à 43

COURRIERS   pages 44 et 45

ABONNEMENTS  dernières pages
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Convention Avosmac
Voici les conventions propres à Avosmac utilisées dans certains articles. 
Nous vous demandons d’apprendre tout cela par cœur pour vous prémunir 
d’une interro surprise.

• : ne pas prendre en compte le gros point et le remplacer par un espace 
(barre d’espace).
<commentaire> : les indications placées entre <…> sont de simples 
commentaires destinés à l’utilisateur. Ils ne sont pas à intégrer au code, 
pas plus que les signes < et >.
La maison ou la petite maison : c’est le répertoire «home», celui qui 
est créé lorsque vous passez par Compte dans le tableau des Préférences 
système. Il contient tous les éléments d’un même utilisateur. Cette maison 
(et son contenu) est ce que vous avez de plus précieux au monde. Nous 

vous suggérons de placer votre maison dans le Dock pour y avoir accès 
plus vite.
Le tilde ~ s’obtient en combinant les touches Alt-N puis espace
(Alt-ç sur     clavier QWERTY)
L’anti slash \ s’obtient en combinant les touches
Alt-Maj-/ (Maj-/ sur clavier QWERTY)
Le pipe | s’obtient en combinant les touches Alt-Maj-L
(Alt-/ sur clavier QWERTY)
Pomme : il s’agit des deux touches frappées d’une pomme de part
et d’autre de la barre d’espace du clavier
Alt : ou touche Options existe aussi de part et d’autre du  clavier
Maj : ou touche Shift sur les PC, il s’agit de la touche avec laquelle on 
obtient des lettres majuscules. Elle  présente une flèche pointant vers le 
haut (à gauche du    clavier)
Répertoire = Dossier

Gratuit

L   y a quelques mois, Steve Jobs a créé une vraie secousse 
dans le monde bien rangé du Mac en annonçant la migration 
de tous les ordinateurs de la Pomme vers les processeurs 

Intel, ceux qui équipent déjà une majorité de PC.
La surprise passée, voici que l’on annonce le premier « MacIn-

tel » pour le mois prochain. C’est Benjamin A. Reitzes, un analyste 
de la société UBS Investment Research qui avance qu’Apple pour-
rait bien être capable de sortir un Mac mini X86 (X86 pour puce 
PC) dès le mois de janvier. Apple profiterait de la Macworld Expo, 
le show de San Francisco souvent fertile en grandes annonces, 
pour sortir le premier petit monstre. 

Le gars s’avance peut-être un peu même si la technologie est 
prête et Mac OS X capable de tourner sans difficulté sur puce In-
tel. Car Steve Jobs n’avait pas programmé une telle sortie avant 
le mois de juin 2006. Choisir un Mac mini pour porter la révolution 
du microprocesseur chez Apple paraît un peu contre productif. Un 
Mac mini rapporte peu et le modèle est loin de se vendre comme 
des petits pains. 

D’un autre côté, ce peut être un moyen d’inciter avant tout les 
utilisateurs de Windows à passer au Mac. Ils sont déjà nombreux 
à choisir le Mac, un Mac mini intellisé à un prix canon pourrait finir 
de les décider sans hypothéquer l’image du reste de la gamme. 

D’autres tablent plutôt sur un portable comme premier modèle 
équipé d’une puce Intel. Quoi qu’il en soit, voici deux minutes que 
vous lisez un article qui ne donne somme toute aucune informa-
tion.

• NeoOffice : Une nouvelle mouture 
de ce clone d’OpenOffice.org est disponible 
sous MacOS X en version 1.2. NeoOffice, 
écrit en Java, reprend les mêmes fonc-
tions qu’OpenOffice.org à la nuance près 
que l’application gratuite n’a pas besoin 
de X11 pour fonctionner. Elle s’intègre en 
outre mieux à l’interface Aqua de Mac OS X. 
Elle n’en est pas plus réactive pour autant. 
Cette version 1.2 n’exploite que la version 
1.1.5 d’OpenOffice qui existe pour sa part 
désormais en version 2.

www.neooffice.org/

• VLC : L’extraordinaire lecteur vidéo 
universel VLC de la Videolan.org se pré-

sente en version 0.84. Les changements 
sont nombreux mais n’apportent pas des 
nouveautés spectaculaires pour l’utilisateur 
classique de ce lecteur multimédia.

Notez que l’équipe a pu acquérir un 
PowerMac G5 grâce aux dons des incondi-
tionnels de ce logiciel gratuit, au nombre 
desquels figuraient MacBidouille et Avos-
mac.

www.videolan.org/

• Inkscape : Le logiciel de dessin vec-
toriel open-source est désormais disponible 
en version 1.4.3. Cet excellent outil gratuit 
qui peut consoler les nostalgiques de Claris 
Draw, est téléchargeable en version auto-

nome pour MacOS X (sans passer par Fink). 
Il nécessite toutefois la présence de X11.

www.inkscape.org/

• OpenOffice.org : Disponible en ver-
sion 2.0 (voir dans ce numéro), la suite bu-
reautique issue de StarOffice et distribuée 
en application libre passe en version 2 avec, 
grande nouveauté, le support de bases de 
données autonomes. Les formulaires sont 
désormais intégrés et parfaitement fonc-
tionnels comme dans Filemaker Pro.

www.openoffice.org/

Logiciels libres et Macintosh

Rumeur

MacIntel en janvier

i

BitTorrent

Vidéo payante en ligne
’EXEMPLE de l’iTunes 
Music Store mis en 
place par Apple et 
qui accapare 70 % du 

marché de la vente légale 
de fichiers musicaux en ligne a laissé des traces. Cette fois les 
éditeurs de vidéos semblent bien décidés à ne pas se laisser dic-
ter leur loi par Apple et prennent les devants. Jusqu’à présent 
plutôt opposée au principe de l’échange Peer2Peer via internet 
(d’ordinateur à ordinateur), la MPAA (Motion Picture Assoication of 
America) avec le fondateur de BiTorrent (cf Avosmac n°56 p.10), 
a scellé un accord pour construire un service de paiement et de 
téléchargement légal de vidéos. L’écueil reste la qualité des fi-
chiers proposés. Si l’on se réfère aux vidéos vendues par Apple via 
son iTunes Music Store, il reste encore du chemin à parcourir en 
matière de qualité.

www.bittorrent.com

l

Plusieurs lecteurs qui ont souhaité renouveler leur abonnement 
ont essuyé de la part de Paypal un refus d’utiliser leur carte ban-
caire sous prétexte qu’elle était déjà enregistrée. C’est normal !

La première fois que vous vous êtes connecté à Paypal, le ser-
vice a enregistré votre carte, vous a attribué un mot de passe et 
une identité.

Pour pouvoir renouveler l’abonnement, il faut tout simplement 
se reconnecter avec le même Login et le même mot de passe. 

1er trimestre 2006 - hors série n° 16 - page 3



actualité Les actus de Christophe Laporte (www.                  .com)

> T’aurais pas 1,25 milliard
de dollars ?

Comment s’assurer d’avoir de la mémoire 
Flash en quantité et à bon prix tout en 
étouffant la concurrence ? Tout simple-
ment en faisant un gros chèque aux prin-
cipaux fabricants de mémoire Flash. Apple 
versera 1,25 milliard de dollars d’ici trois 
mois à Hynix, Intel, Micron, Samsung Elec-
tronics et Toshiba. En échange de cette 
belle somme, les partenaires d’Apple s’en-
gagent à lui réserver une certaine quan-
tité de leur production respective à un prix 
favorable. On n’est pas loin d’un abus de 
position dominante...

> De la mémoire flash dans les Mac ?

La mémoire Flash qu’Apple achète à si bon 
prix n’est pas forcément limitée à l’iPod. 
Nombreux sont ceux qui pensent qu’Apple 
pourrait l’intégrer un jour ou l’autre dans 
nos Macintosh. L’utilisation de la mémoire 
Flash permettrait au Macintosh de démar-
rer presque instantanément, les données 
n’ayant pas à être d’abord chargées en 
mémoire. Intel, le nouveau partenaire 
d’Apple en matière de processeurs, plan-
che d’ailleurs sur le sujet depuis quelque 
temps déjà.

> Gtk mieux intégré à Mac OS X 

De nombreux logiciels open-source tels 
que Gimp, Gnumeric, GNOME ont recours 
à la bibliothèque Gtk+ pour tout ce qui 
touche les interfaces graphiques. La so-
ciété Immendio AB est en train de mieux 
l’intégrer à Mac OS X. Ce port utilisera Co-
coa et permettra à terme l’utilisation des 
applications citées précédemment sans 
avoir à installer X11 comme c’est le cas 
maintenant. Voilà qui devrait faciliter la vie 
des développeurs et égayer l’usage des lo-
giciels libres !

> LaCie joue au Lego 

LaCie lance sur le marché un nouveau 
pavé, une nouvelle brique plutôt colorée 
cette fois. Le fabricant propose en effet de 
nouveaux disques durs conçus pour s’em-
piler les uns sur les autres… comme des 
briques de Lego. Disponible en plusieurs 
versions (de 160 à 500 Go), le Brick Desk-
top adopte évidemment un look tout par-
ticulier. La connectique, elle, est USB 2.0. 
Les prix vont de 129,99 ! à 429,99 !.
Jouant sur la même apparence, carrée cet-
te fois, proposant, au choix l’USB 2.0 seul 
ou l’USB 2.0 et le FireWire, le Brick Mobile 

est alimenté par l’ordinateur 
auquel il est relié. Les prix 
vont de 109,99 ! (40 Go) à 
339,99 ! (120 Go).

> Une belle année pour AAPL

L’heure des bilans approche. Pour l’action 
Apple, 2005 devrait être un très bon cru. 
Depuis quelques mois, le titre vogue de 
sommet en sommet. Mercredi 23 novem-
bre, le titre a fini la séance à un nouveau 
plus haut à 67,11 $. En l’espace d’un an, 
le titre s’est envolé de plus de 100 %. Une 
très belle performance...

> Rome en 2006

Le premier Apple Store européen continen-
tal devrait ouvrir - à la surprise générale - 
à Rome. Depuis quelque temps, la Pomme 
est à la recherche de personnel dans la 
capitale romaine. Il se murmure que la 
boutique pourrait être située Via Condotti 
ou Via del Corso et que l’ouverture devrait 
avoir lieu dans le courant de l’année pro-
chaine. Rappelons, tant qu’on y est, que la 
Pomme a inauguré hier son nouveau point 
de vente britannique, le quatrième, à Man-
chester, au Trafford Centre. 

> Au jeu du chat et la souris... 

Les hackers viennent de marquer un nou-
veau point. OSx86 Project affirme que 
«Maxxuss» a réussi à faire fonctionner 
Mac OS X 10.4.3 sur PC. La personne a 
semble-t-il réussi à contourner les protec-
tions d’Apple sans trop de difficultés. Selon 
OSx86 Project, Apple n’aurait pas encore 
mis en place les nouveaux procédés visant 
à mieux protéger son système. À quelques 
semaines de la présentation des premiers 
iBook sous Intel si l’on croit les sites de 
rumeur, Apple a encore fort à faire dans 
ce domaine.

> Des précisions sur Mac OS X 10.4.3

OSx86 Project donne quelques informa-
tions intéressantes concernant la dernière 
version de Mac OS X 10.4.3 pour Intel. La 
build 8F1111A contiendrait une nouvelle 
version de Rosetta. Celle-ci offrirait un 
support complet du G4 et notamment d’Al-
tivec. Outre une meilleure compatibilité, 
cette nouvelle version de Rosetta gagne-

rait également en performances lorsqu’elle 
émulerait des applications disposant de 
portions de code pour Altivec. D’autre 
part, cette build intégrerait des pilotes 
pour les puces de la gamme mobile 9xxx 
d’ATI. OSx86 Project remarque que Nvidia 
est pour l’instant absent de ces versions 
préliminaires. De là à dire qu’Apple a choisi 
son constructeur de puces vidéo pour les 
premiers Mactel....

> L’Apple expo stagne

L’Apple expo a accueilli cette année 56 545 
visiteurs soit 3 % de plus que l’année der-
nière. Le salon a été le rendez-vous autant 
des professionnels (49 %) que du grand 
public (51 %). Si ces chiffres n’ont rien de 
déshonorant, ils ne feront pas oublier une 
édition bien terne de nouveautés et privée 
de keynote à la dernière minute. L’édition 
2006 aura lieu du 12 au 16 septembre.

   
> Microsoft veut standardiser

Il y a du nouveau du côté de Microsoft. 
Alors que le géant du logiciel a créé de fait 
des standards avec Word ou encore Excel, 
il semble vouloir désormais promouvoir 
le XML pour Office 12, la prochaine mou-
ture de la suite bureautique. Du côté de 
Redmond, on explique qu’on veut par là 
«fournir le plus haut niveau d’interopérabi-
lité entre les logiciels d’aujourd’hui et ceux 
de demain».
Du coup, Microsoft a fait le choix de pré-
senter son Office Open XML à l’ECMA, le 
consortium qui doit normaliser certaines 
technologies informatiques (au sein du-
quel on trouve une société qu’on connaît 
bien : Apple).
Office Open XML, si son développement 
se poursuivait, serait alors ouvert, ce qui 
permettrait aux autres développeurs de 
l’utiliser et de l’améliorer.
C’est que face à lui, il y a un autre «for-
mat» en gestation : l’OpenDocument de 
Sun, soutenu, lui, par des pointures com-
me Adobe, Google, etc.
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EPUIS le 1er décembre, le ta-
rif des iPod Nano mais aussi des 
iPod Shuffle a sensiblement baissé 
grâce à la révision de la réglemen-

tation française sur la taxation des mé-
moires Flash. Jusqu’à présent, ce type de 
mémoire était frappé d’une taxe de plus 
de 10 ! par Go de mémoire. Ainsi, l’iPod 
Nano d’une capacité de 4 Go subissait 
un surcoût de 51,44 ! par le seul effet 
de cette taxe prévue pour rémunérer les 
artistes en compensation de la pratique 
courante désormais du peer2peer et de 
la copie privée. Tout support d’enregistre-
ment (CD, DVD, disque dur, etc) est as-
sujetti à cette taxe prélevée par la SORE-
COP. Le changement de réglementation 
permet de baisser à 8 ! la taxe sur l’iPod 
Nano à 4 Go.

Le Nano 2 Go passe à 223 ! TTC et le 
4 Go à 277 !. L’iPod Shuffle passe, lui, à 
107 ! TTC pour le 512 Mo et 142 ! TTC 
pour le 1 Go.

Dans son élan, Apple en a aussi pro-
fité pour baisser les prix des iPod qui uti-
lisent un disque dur et qui ne sont pas 

concernés par cette nouvelle règle. Ils 
sont maintenant vendus à 325 ! TTC pour 
le 30 Go et 446 ! TTC pour le 60 Go.

A noter qu’Apple semble disposé à fai-
re un geste. Des acheteurs récents d’un 

iPod on reçu un  mail leur indiquant qu’ils 
recevraient un remboursement du trop 
perçu.

Bon Nano 2006

d

Les mises à jour
cosmétiques d’Apple

Vous serez bien avisé de faire le petit 
entretien mensuel de votre Mac en télé-
chargeant depuis le menu Pomme -> Mise 
à jour de logiciels, la plus récente mise à 
jour de sécurité : 2005-009 version 1.0 de 
5,9 Mo. Cette mise à jour inclut les compo-
sants suivants :

apache_mod_ssl
CoreFoundation
CoreTypes
curl
iodbcadmin

OpenSSL
Safari
sudo
syslog

Pour obtenir des informations détaillées sur 
cette mise à jour, consulter : 
www.info.apple.com/kbnum/n61798-fr 

Apple propose également iPod Updater 
2005-11-17 qui inclut le nouveau logiciel 
iPod 1.1.3 destiné à résoudre des problè-
mes rencontrés avec l’iPod Shuffle.

iPod Updater 2005-11-17 contient les 
mêmes logiciels qu’iPod Updater 2005-10-
12 pour tous les autres modèles d’iPod.

Les premiers iPod utilisaient une prise 
Firewire classique pour se connecter à 
un Mac ou à un PC. Les nouveaux iPod 
sont équipés d’un connecteur maison qui 
nécessite un câble spécifique mais qui 
reste compatible Firewire, un port sur 
lequel Apple touche des royalties ! 

Microsoft et une quarantaine de 
camarades veulent casser cette logique 
et créer leur propre standard histoire de 
détrôner le trublion. Le but est de créer 
un standard universel qui n’oblige pas à 
passer à la caisse chez Apple.

Entre ports

’HÉGÉMONISME d’Apple en matière de musique en ligne ne pouvait laisser insensibles les 
autres acteurs du marché. Alors que tous boudaient le système Mac et même Linux, voici que 
Real Networks ouvre Rhapsody.com (1,3 million d’abonnés) son service en ligne de vente de 
musique aux utilisateurs de Mac et à ceux de Linux. Cette nouvelle est surtout la bienvenue 

pour les utilisateurs de système libre qui souhaitaient acheter légalement de la musique et qui en 
étaient réduits à passer par SharpMusique (cf Opensource-Magazine n°2), un système permettant 
d’acheter de la musique sur l’iTunes Music Store. Rhapsody.com s’appuie désormais sur les tech-
nologies du web sans nécessiter de lecteur spécifique à la plate-forme. Les utilisateurs doivent 
toutefois télécharger et installer un élément : RhapsodyPlayerEngineInstaller. 

Microsoft va faire la promotion de ce service via son service MSN. Si les fichiers pourront être 
lus sur toutes les plates-formes, il ne sera possible aux propriétaires de Mac ou de Linux de les 
exploiter directement sans passer par le web. Quoi qu’il en soit, il faudra aux Européens patienter 
jusqu’en avril 2006 date à laquelle le service devrait être enfin accessible ailleurs qu’aux USA.

www.rhapsody.com/

RHAPSODY Un concurrent à l’iTunes Music store

l
Skype, le logiciel de téléphonie sur 

IP  supporte désormais la visiophonie. 
Il va désormais être possible de se 
téléphoner depuis n’importe quel or-
dinateur vers un autre ordinateur ou 
même un poste fixe (à condition dans 
ce dernier cas d’acheter des crédits) 
et de se voir en même temps. Skype, 
propriété désormais d’eBay, ne permet 
pas à plus de deux correspondants de 
se voir simultanément, mais un grand 
pas est fait vers la visioconférence. La 
version pour Windows est prête, celles 
pour Mac OS X et Linux devrait l’être 
en janvier. http://skype.com

Skype, le grand gourou
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Musique

EUSSE qui voudraient apprendre à jouer de la guitare 
ont désormais un prof à domicile : leur Mac chéri. On 
trouve dans le commerce d’étonnants logiciels pour ap-
prendre à grattouiller les six cordes. Bien sûr, il faut 

débourser quelques dizaines d’euros mais c’est encore moins 
cher que les cours à la MJC du coin.

Montparnasse multimédia vient de publier une série de 
logiciels pour apprendre à jouer de plusieurs instruments et 
notamment de la guitare.

Le premier niveau est destiné aux débutants.
En s’y tenant un peu chaque jour, même les plus nuls et 

même ceux qui ne comprennent rien au solfège peuvent espé-
rer jouer «Les portes du pénitencier» ou «jeux interdits» sur 
la plage l’été prochain.

Le premier intérêt du logiciel réside dans des vidéos qui 
montrent bien la position des mains et la tenue de l’instru-
ment. Mais surtout il propose des tablatures animées qui illus-
trent parfaitement où et comment il faut placer et déplacer ses 
petits doigts sur les cordes. Du coup, il n’est même pas besoin 
de connaître le solfège et l’harmonie. Le cédérom propose 
aussi un métronome, un dictionnaire d’accords et même un 
accordeur pour jouer juste.

En 165 leçons, le débutant peut progresser à son rythme 
dans des styles très variés qui vont de la guitare classique aux 
Rolling stones. Bien sûr, il ne faut pas espérer jouer comme 
Django Reinhart ou Peter Clapton au bout de cette première 
méthode, mais elle donne de bonnes bases sans se prendre 
la tête.

Certes, tout ça reste très élémentaire, mais les vieux grat-
teux blasés ricaneront moins devant un autre volume de cette 
série intitulé : «Les légendes du blues».

On y trouve dix morceaux joués par B.B. King, Stevie Ray 
Vaughan, Muddy Waters, John Lee Hooker… décortiqués note 
à note sur partitions et sur tablatures. Là encore, des petites 
fenêtres permettent de voir où les «guitar heroes» placent 
leurs doigts agiles sur le manche, en même temps qu’on écou-
te le morceau original.

Mais attention les yeux ! Comme ces vieux requins jouent 
très vite, une fonction permet de régler le tempo grâce au 
mode «midi», afin de faire redéfiler tout doucement la tabla-
ture et bien capter le jeu des doigts. Il n’y a plus ensuite qu’à 
répéter au ralenti les difficultés jusqu’à ce qu’elles rentrent 
bien dans les doigts. Évidemment, en mode midi, la «guitare» 
de B.B. King sonne comme un Bontempi asthmatique, mais 
c’est vraiment pratique. Pas chères, bien faites et progressi-
ves, ces méthodes d’apprentissage sont d’un indéniable inté-
rêt pour apprendre à jouer de la guitare. Elles s’adressent en 
priorité aux novices qui découvrent l’instrument, ou alors aux 
musiciens confirmés désireux de travailler leur technique. Cela 
dit, elles ne remplaceront jamais la rencontre avec d’autres 
musiciens, ni le jeu en groupe ou en orchestre.

Jean-Yves Lignel.

Apprendre la guitare sur Mac

www.mindscape.com
Fonctionne de Mac 8.6 à 10.4

c

C’est très pratique : on peut à la fois écouter le morceau original, 
lire la partition ou la tablature, et suivre le jeu des doigts
sur la vidéo animée.

Il faut bien 
accentuer 

cet accord 
de Ré !
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ClamXav

Investir dans un anti-virus ?

Inutile, quoi que...

ClamXav recherche les virus qui n’existent pas sur Mac.

 force de s’entendre dire que les virus n’existent pas 
sur Macintosh, ils finiront bien par arriver ! Bien qu’il 
soit peut probable qu’ils apparaissent dans l’immédiat, 
il est toujours bienvenu de prendre quelques précau-

tions. Inutile cependant d’investir dans des logiciels commer-
ciaux hors de prix, alors qu’il existe aujourd’hui un 
anti-virus OpenSource répondant au doux nom 
de ClamAV. La version pour Mac, rebaptisée 
ClamXav, est librement téléchargeable sur le site 
du développeur (cf.lien). L’application ne brille 
certes pas par son esthétique, mais remplit bien 
les tâches qu’on lui demande en scannant les fichiers 
sur votre disque dur à la recherche des intrus. Comme pour 
tous les anti-virus, il est nécessaire par la suite de vous tenir 
informé des mises-à-jour (souvent fréquentes) de l’applica-
tion...

Philippe R.

à

ClamXav : http://www.markallan.co.uk/
clamXav/index.php

ClamXav 1.0.1, 7.1 Mo, pour Mac OS 10.3 et 10.4 : 
http://www.markallan.co.uk/
clamXav/ClamXav_1.0.1.dmg

ClamXav 1.0.1, 2.8 Mo, pour Mac OS 10.2 :
http://www.markallan.co.uk/clamXav/previous/

clamXav_0.8.7c_complete.zip 

Une tablature, c’est un système de notation très bien adapté 
à la guitare et qui permet de passer du système classique du 
solfège. Dans une tablature, les lignes  horizontales représen-
tent les six cordes de la guitare, la plus aiguë en haut, et la plus 
grave en bas. Les numéros représentent les cases (entre les 
barrettes) sur lesquelles il faut appuyer.

Voici, par exemple, la tablature simplifiée de l’air «D’au clair 
de la lune».

---------0-----0---------
-1-1-1-3---3-1---3-3-1---
-------------------------
-------------------------
-------------------------
-------------------------

Et celle du début des “Trois orfèvres”
--------------3--
-3-3-----3333----
-----4-4---------
-----------------
-----------------
-----------------

Le système des tablatures est très pratique. Au point que 
bien des guitaristes, et même des «pros» (!) avouent parfois ne 
pas savoir lire une partition.

On peut donc très bien débuter la guitare sans rien connaî-
tre au solfège. De plus, en apprenant les positions des doigts, 
(ce qu’on appelle les accords), le débutant guitariste aborde 
sans le savoir les techniques très savantes de l’harmonie. Même 
Johnny Halliday connaît des accords de guitare. C’est donc à la 
portée de tout le monde…

Il est à noter que désormais de très nombreux sites propo-
sent des forums d’échanges de tablatures. Ces deux-là sont très 
bien et sont gratuits.

J’voudrais bien, mais j’sais point la musique

http://www.abc-tabs.com/
http://www.partoch.com/
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Messagerie

E logiciel Thunderbird peut-il rem-
placer avantageusement le logiciel 
Mail d’Apple ? Pour mémoire, Thun-
derbird est à Mail ce que Firefox est 

à Safari, de solides solutions alternatives 
disponibles sur toutes les plates-formes 
du marché.

Acte 1 : Quittez Mail et lancez Thun-
derbird. Vous notez que vous pouvez im-
porter les paramètres de messagerie d’un 
autre compte Thunderbird si celui-ci exis-
te déjà. Lorsque ça n’est pas le cas, vous 
ne pouvez qu’Abandonner ou continuer 
en cliquant sur Suivant. 

Acte 2 : Paramétrer un nouveau 
compte. Hélas, il n’est pas possible d’im-
porter le profil des comptes enregistrés 
dans Mail. Il va donc falloir reprendre à 
zéro. Cochez Compte de courrier électro-
nique et cliquez sur Suivant. Renseignez 
votre identité et votre adresse mail. Au 
panneau suivant, cochez POP, indiquez le 
nom du serveur de votre fournisseur d’ac-
cès à la messagerie (pop.wanadoo.fr ou 
mail.aquaray.com par exemple) et le nom 

du serveur de sortie des messages (smtp.
wanadoo.fr par exemple). Les noms d’uti-
lisateurs entrant et sortant peuvent être 
ou non modifiés.  Le nom du compte est 
laissé à votre entière liberté. Enfin, vous 
pouvez télécharger les messages une fois 
que vous avez vérifié les paramètres dans 
le dernier panneau.

Acte 3 : Entrez le mot de passe de 
messagerie. Si un message d’erreur per-
siste, déroulez le menu Outils pour vérifier 
et corriger les Paramètres de compte qui 
sont sans doute mal indiqués. Vous note-
rez à cette occasion qu’il est possible de 

« laisser les messages sur le serveur », 
ce qui est utile si quelqu’un d’autre doit 
consulter les mêmes messages. N’oubliez 
pas tout de même que laisser les messa-
ges sur le serveur finit par le saturer et 
par bloquer la boîte. Il faudra un jour ou 

l’autre la purger. Il vaut donc mieux ne 
pas laisser les messages sur le serveur.

Acte 4 : Test. Pour tester un logiciel 
de messagerie, c’est simple comme tout. 
On rédige un nouveau message (cliquez 
sur Ecrire dans la barre d’outils), indiquez 
votre propre adresse mail puis un Sujet 
bidon et envoyez ce message. Si ce mes-
sage est bien parti, il sera copié dans le 
dossier Envoyés. Vous pourrez surtout 
le vérifier en cliquant, quelques minutes 
plus tard, sur Relever. En toute logique, 
ce message doit revenir dans votre boîte 
puisque vous vous l’êtes adressé. Si c’est 
le cas, votre Thunderbird est prêt à fonc-
tionner en entrée comme en sortie.

Acte 5 : Foire aux questions :
• Le système permet-il d’effec-

tuer une recherche si Spotlight est 
désactivé ?

- Oui ! Et c’est là tout l’intérêt de Thun-
derbird sous Tiger. Ainsi, vous pouvez 
désactiver Spotlight pour gagner en per-
formances et en réactivité et, contraire-
ment à Mail, continuer de bénéficier d’une 
recherche par contenu dans vos mails en 
utilisant Thunderbird.

• Est-il possible d’importer les 
messages de Mail dans Thunder-
bird ?

- La commande Outils/Importer ne le 
permet pas. Il existe néanmoins une tech-
nique pas trop contraignante. Mais l’im-
portation ne peut se faire depuis Mail que 
dossier par dossier.  Dans Mail, choisissez 
un dossier contenant des mails, puis sé-
lectionnez tout ou partie des messages 
de ce dossier, sélectionnez Fichier/Enre-
gistrez sous... et sauvegardez ces mails 
sur le bureau au format « source du 
message brut ». Dans Thunderbird créez 

Thunderbird peut-il remplacer Mail ?

l

L’importation ne concerne pas Mail.

Complétez votre profil.

La plupart des fournisseurs ont un serveur pop.

Entrez ici les paramètres donnés par votre 
fournisseur d’accès à internet.

Spotlight désactivé, la recherche 
fonctionne toujours.
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www.mozilla-europe.org/fr/products/thunderbird/

un nouveau dossier 
(Fichier/Nouveau/  
Nouveau dossier...)que vous pouvez appe-
ler : «Importation» par exemple. Quittez 
Thunderbird. Rendez-vous ensuite dans 
votre Bibliothèque (celle de votre maison). 
Ouvrez le dossier Thunderbird, puis Profiles, 
puis le dossier marqué d’un code chiffré et 
d’une extension .default. Ouvrez le dossier 
Mail, puis Local folders et déplacez le fichier 
de mail créé sur le bureau vers le dossier 
Importation.sbd. Relancez Thunderbird. Vos 
mails sont là ! Vous pourrez répéter l’opéra-
tion avec tous les dossiers.

• Que puis-je faire avec les Exten-
sions (menu Outils) ?

- La force des projets Mozilla (Firefox, 
Thunderbird, Mozilla, etc) est que les appli-
cations peuvent s’enrichir d’extensions qui 
apportent de nouvelles fonctions. Celles dis-
ponibles pour Thunderbird sont, hélas, peu 
nombreuses et peu passionnantes. 

• Peut-on personnaliser l’entête en 
ajoutant un logo ou une photo ?

- D’une manière aussi simple que Mail, 
non à notre connaissance. Mais il est possi-
ble de rédiger des mails au format HTML qui 
autorise toute sortes de fantaisies, y com-
pris celle d’ajouter votre logo.

• Peut-on établir des règles de fil-
trage de mails ?

- Oui, de la même manière qu’avec Mail, 
il est possible de créer des procédures de 
filtrage et d’élimination de messages indési-
rables. Allez dans le menu Outils/Filtres de 
message et cliquez sur le bouton Nouveau 
pour créer votre filtre. Le bouton «Indésira-
ble» permet aussi d’apprendre à Thunder-
bird à faire le tri seul.

Trop peu d’extensions existent pour Thunderbird.

2T4Mac

ANS le n°54 vous parlez 
du logiciel pour appren-
dre la dactylo» Meilleur 
en dactylo» Ce logiciel 

étant payant, bon marché mais 
tout de même payant, j’ai recher-
ché une solution moins onéreuse 
et j’ai trouvé  le donationware 
«2T4Mac» de Valentin Vassile-
vski. Simple de présentation, ce 
logiciel reconnaît automatique-
ment le style de clavier employé. 
A tester par ceux qui tout comme 
moi habitent en Suisse romande 
et ne trouvent pas de logiciel ap-
proprié à leur clavier.

Raymond Lambelet.

http://homepage.mac.com/typetrainer4mac/Menu1.html
http://homepage.mac.com/deray/web/app/TypeTrainer4Mac.html

La dactylo gratuite

Plutôt sommaire, ce logiciel est correct
pour s’entraîner.

s

Stuffit Expander

À la bonne heure
A gamme de 
produit StuffIt 
passe en version 
10. Comme par le 

passé, le très célèbre 
StuffIt Expander est 
désormais disponible 
seul (sans DropStuff) 
et reste gratuit. Il 
reconnaît plus d’une 
vingtaine de formats de 
compression dont sitx, 
le format propriétaire 
qui propose une 
excellente compression tout en évitant la corruption des données. Pour 
installer et utiliser cette nouvelle mouture, vous devez posséder la version 
10.3 de Mac OS X minimum. Sous Mac OS X version 10.4, un petit bug 
d’affichage peut apparaître lors de la décompression d’archives StuffIt 5 
(sit). Après la décompression, si aucun élément n’apparaît dans le dossier 
obtenu, il vous faudra désactiver l’affichage des informations dans les 
options de présentation.

Dans le Finder, ouvrez une nouvelle fenêtre (Commande-N) et dans le 
menu Présentation, choisissez «Par icônes» puis «Afficher les options de 
présentation». Dans la fenêtre des options, désélectionnez «Afficher les 
informations».

Cette nouvelle version possède un autre petit bug... Dans certains cas, 
le temps de décompression restant estimé affiche des valeurs totalement 
surréalistes. Environ 230 000 ans, juste le temps de boire un café !

Joël Barrière.

www.stuffit.com/mac/expander/

l

Changer la présentation peut faire apparaître
le disparu.
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Alternatives à Mactylo

LORS qu’il fonctionnait à merveille 
sous MacOS X Panther, l’indispen-
sable (enfin pour nous) TypeIt-
4Me, autrement dit Mactylo (25 !) 

paraît nettement plus versatile sous Tiger. 
Au point d’être, dans sa version 2.1, inu-
tilisable. En tout cas, c’est ce qu’il nous 
est arrivé.  Nous sommes donc partis en 
quête d’un remplaçant qui lui soit digne et 
qui soit, si possible gratuit. 

Autant le dire d’entrée, nous n’avons 
pas trouvé de logiciel qui permette, à l’ins-
tar de Mactylo, d’entrer un raccourci dans 
un texte, de valider, puis de voir s’écrire 
la portion de texte pré-enregistrée devant 
s’afficher lorsque le code en question est 
inscrit. C’est pourtant extrêmement prati-
que.  iSnip est l’utilitaire qui se rapproche 
le plus du principe de Mactylo. Il permet, 
une fois paramétré (simple) et les pre-
miers textes entrés en mémoire (facile), 

de les récupérer et de les inscrire dans 
la page courante. Il suffit de dérouler le 
menu iSnip et de sélectionner le texte dé-
siré. Ce n’est pas aussi souple et rapide 
que Mactylo, mais ça n’est vraiment pas 
mal du tout. D’autant plus que c’est gra-
tuit. Une autre alternative intéressante 
est ClipBlock. Son panneau offre la pos-
sibilité d’affecter à 98 boutons un texte 
différent.

Un verrou permet de bloquer le sys-
tème de mémorisation pour éviter que le 
Presse Papiers ne s’y enregistre systéma-
tiquement. Chaque bouton peut être ver-
rouillé et conserver ce qu’il a en mémoire 
à condition que ce contenu soit enregistré 
au préalable. A peine moins pratique 
qu’iSnip, il présente l’inconvénient de 
ne pouvoir être accessible en perma-
nence depuis tous les écrans virtuels 
si vous êtes un adepte de Desktop 

Manager, par exemple. PTHPasteboarb 
conserve les derniers contenus du Presse-
Papiers mais n’est utile que de manière 
ponctuelle lorsque vous devez copier/col-
ler plusieurs plusieurs textes différents 
lors d’une même session. PTHPasteboard 
perd tout à l’extinction.

KoolClip fonctionne un peu de manière 
similaire à PTHPasteboard mais aussi de 
façon plus intuitive et claire en affichant 
depuis la barre des menus, la liste des xx 
éléments mis en mémoire, y compris les 
images. Il suffit de sélectionner la ligne 
qui contient ce que vous souhaitez récu-
pérer pour retrouver vos petits.

www.typeit4me.com/
www.isnip.net/index.shtml

www.netwave.or.jp/~andoh/ClipBlock-e.html
http://kudang.com/koolclip/desktop.html

www.pth.com/PTHPasteboard

Écrire du texte à la chaîne

a

ClipBlock propose 98 options de textes.

iSnip nous semble être la 
meilleure alternative
à Typeit4me,
en moins souple.

Entrez les textes que vous souhaitez rappeler depuis la barre des menus.
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Base de sonnées

A filiale d’Apple Filemaker vient de sortir une nouvelle version de 
son logiciel de gestion de bases de données Filemaker Pro. La 
version 8 est disponible en version de démonstration limitée à 
30 jours. Cette version de démonstration crée toujours un fichier 

invisible .L8457789_1 de 0 octet qui n’est, semble-t-il, pas nécessaire. 
Ce n’est pas grave si vous l’effacez, le fonctionnement de la version de 
démonstration limitée à 30 jours n’en sera pas affecté.

Cette version 8 accroît sa compatibilité avec les produits Micro-
soft (Excel) et sait générer des fichiers Adobe PDF à destination des 
personnes qui ne sont pas équipées de Filemaker. Il est aussi pos-
sible d’envoyer des données par mail plus aisément qu’auparavant 
(cf Avosmac n°54 p.24), de créer des modèles plus sophistiqués, etc.

La version complète de Filemaker Pro coûte 420 !.
www.filemaker.fr/

FileMakerPro passe en 8e 

l

PiquantMenu

La Rolls des menus déroulants
E n’est pas la première fois qu’on en parle dans AvosMac - et peut-
être pas la dernière non plus (voir les n° 41 p. 20 et 49 p. 18). Voici 
un petit utilitaire qui ne cesse d’évoluer. D’une version à l’autre - nous 
en sommes à la version 2.3 depuis le 29 septembre -, l’interface est 

plus soignée, et son développeur Michaël Parrot nous offre quelques nouvel-
les fonctions à chaque mise à jour. Ainsi, outre un menu permettant d’avoir 
accès à toute la musique d’iTunes et de lancer les listes ou les morceaux de 
la Bibliothèque, il est possible de lancer n’importe quel module des Préférences système, ou encore de faire apparaître, par un 
simple clic sur son icône, une fenêtre d’informations sur un dossier ou un fichier.

À partir de là, on peut lire les informations, ouvrir l’élément, en faire une archive, l’envoyer par mail ou le placer dans la 
corbeille. Mais vous trouvez que votre barre de menus est déjà trop encombrée pour accueillir Piquant Menu ? Alors - bonne 
nouvelle ! - vous pouvez déplacer les petits menus de Piquant Menu où vous le désirez sur votre écran. Plus d’excuse, donc, 
pour ne pas adopter ce petit logiciel de navigation. Vous allez dorénavant avoir un accès immédiat à tous vos fichiers ou réper-
toires préférés.

François Giron.

www.mparrot.net/index.php?page=piquantmenu

La palette des menus est détachable.

c

Les nostalgiques d’un menu Pomme MacOS 9 sont servis. Piquant Menu contrôle iTunes.

Les informations
d’un élément peuvent
être affichées.
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Pif Gadget

VOUONS-LE, lorsqu’Apple a pré-
senté « sa » nouveauté Dashboard 
(une resucée de Konfabultor), nous 
étions plutôt sceptiques. Nous pen-

sions que nous n’aurions pas une grande 
utilité de ces bidules ajoutés au système 
et accessibles par une combinaison de tou-
ches qui, soit dit en passant, peut être mo-
difiée dans les Préférences système rubri-
que : Dashboard et Exposé.  Eh bien, nous 
avions mal présumé car Dashboard et ses 
gadgets sont plutôt bien pratiques. Certes, 
Apple a oublié d’intégrer un outil pour gé-
rer les différents gadgets (ou widgets), une 
carence comblée par l’élément de Préfé-
rences système : Widget Manager. Cet outil 
permet de désactiver certains widgets sans 
avoir à les désinstaller.  La collection des 
gadgets est déjà monstrueuse comme peut 
en convaincre la liste disponible sur le site 
Apple avec plus de 1300 widgets disponi-
bles !  Inutile de dresser une liste de ces 
gadgets. Mais on peut citer quelques gadgets bien pratiques :

• TVSnooper : permet d’avoir la liste des programmes TV des chaînes françaises
http://dashboardwidgets.com/showcase/details.php?wid=551

• M@Radio : le plus court chemin, le plus facile aussi, pour écouter des radios françaises
www.dashboardwidgets.com/showcase/details.php?wid=1157

• iCal Events : affiche les événements iCal à venir
www.dashboardwidgets.com/showcase/details.php?wid=483

• MySQL : permet de lancer le serveur MySQL et Apache d’un clic sans démarrer MAMP
www.apple.com/downloads/dashboard/networking_security/mampcontrol.html

Il est bon de savoir que le petit indicateur « i » présent sur tous les gadgets permet de modifier les paramètres, préférences et 
comportement des widgets. 

Dashboardage !

Gérer Dashboard : www.downtownsoftwarehouse.com/WidgetManager/
La collection Apple : www.apple.com/fr/downloads/dashboard/

Le site Dashboardwidgets : www.dashboardwidgets.com/showcase/

a

Très vite, Dashboard débordera d’outils aussi indispensables et qu’encombrants.

WidgetManager
permet de gérer
les éléments
de Dashboard.

Dashboard
peut apparaître

avec un raccourci
modifiable. 
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ES logiciels de comptabilité person-
nelle existent sous Mac tout autant 
que sous Windows. L’éditeur Ciel! 
propose une gamme complète de 

produits destinés aussi bien au particulier 
qu’aux entreprises. L’application « Tous 
Comptes Faits » d’Innomatix jouit aussi 
d’une bonne réputation sur Mac comme 
sur PC et ne coûte que 59 ! (200 ! en 
version entreprise).  Mais si vous êtes 
d’une nature franchement économe, 
vous pouvez vouloir encore moins cher. 
Le logiciel de comptabilité Grisbi (n°51 
p.47) peut vous rendre service même si 
son apparence n’est pas très sexy.

Ses fonctions sont en revanche tout 

à fait convaincantes pour effectuer ses 
comptes personnels. L’installation sous 
MacOS X peut s’effectuer de plusieurs 
manières. La plus simple consiste à té-
lécharger Grisbi en application autonome 
compatible Tiger depuis le site de Vin-
cent Marqueton qui a eu le bon goût de 
compiler la chose pour Fink. Vous l’aurez 
compris, outre cette version téléchargea-
ble autonome, vous pouvez passer par 
Fink pour installer Grisbi.

La troisième solution, notamment si 
vous souhaitez disposer d’une version 
plus récente, consiste à télécharger de-
puis le site des développeurs de Grisbi, 
le « paquet avec toutes les dépendan-

ces » dans la section MacOS X. C’est un 
peu lourd mais parfaitement fonctionnel. 
Contrairement à Fink où le logiciel s’ins-
talle dans le répertoire /sw/bin/grisbi, ici, 
il se loge dans le répertoire /opt/local/
bin/grisbi. Une fois installé, vous pourrez 
paramétrer X11 de telle sorte qu’il puisse 
ouvrir Grisbi sans avoir à entrer cette 
commande à chaque fois. Allez dans le 
menu Applications de X11 et choisissez : 
Personnaliser ce menu. Créez un nou-
veau raccourci et entrez la commande de 
lancement.

Une autre option d’installation consis-
te à utiliser PortAuthority (le jour où il 
sera enfin correctement fonctionnel...) 
pour installer la version disponible par 
DarwinPorts.  Dans tous les cas, X11 est 
requis. Il se trouve normalement dans le 
dossier Applications>Utilitaires ou sur les 
CD/DVD d’installation de MacOS X.

Et si vous touchiez au Grisbi ?
Comptes bancaires

A propos de Grisbi

Grisbi est un logiciel vous permettant de gérer 
votre comptabilité personnelle sous toutes les 
plates-formes informatiques. Le principe de base 
d’un tel logiciel est de vous permettre de classer 
vos opérations financières, quelles qu’elles soient, 
de façon simple et intuitive, afin de pouvoir les 
exploiter au mieux en fonction de vos besoins. 
Grisbi a pris le parti de la simplicité et de l’effica-
cité pour un usage de base, sans toutefois exclure 
la sophistication nécessaire à un usage avancé. 
Les fonctionnalités futures tenteront toujours de 
respecter ces critères.

Grisbi est compatible MacOS X 10.3 et 10.4 (Panther et Tiger).

Tout sur la gestion sur Mac : www.macgestion.com
Tous Comptes Faits : www.innomatix.com

Grisbi autonome : http://vincent.marqueton.com/grisbi

Une fois le compte créé, il est aisé d’entrer ses opérations financières. Grisbi supporte l’ouverture de plusieurs comptes.

l

Cette commande
permet de lancer
Grisbi depuis X11.
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Mat2Lab-Like

Rapido write

UTRE iSnip qui peut être une so-
lution alternative au shareware 
Mactylo (TypeIt4Me), il existe un 
nouvel utilitaire extrêmement pro-

metteur : RapidoWrite. Ses fonctionnalités 
sont très proches de TypeIt4Me sans en 
avoir encore vraiment toute la souplesse.  
Le principe est le suivant. Vous combinez 
trois touches (Alt-Majuscule-Retour par 
défaut), une petite fenêtre flottante paraît 
dans laquelle vous pouvez entrer un mot 
code qui déclenchera l’inscription dans la 
page de texte en cours, de la portion de 
texte pré-enregistrée.

Pour paramétrer ce texte répétitif, cli-
quez sur le petit i présent à droite de la 
petite palette.

Dans la colonne de gauche, vous dis-
posez de 100 possibilités de raccourci. 
Chacun correspond au champ Subject 
situé à droite. Une fois le sujet entré, va-
lidez et écrivez le texte qui s’inscrira lors-
que le raccourci (sujet) sera inscrit dans la 
palette flottante.

Cliquez sur le bouton «Save modifica-
tion» pour prendre en compte le nouveau 

texte. Par exemple, lorsque nous écri-
vons : @avm dans la palette, c’est toute 
l’adresse d’Avosmac qui s’inscrit dans la 
page ouverte du traitement de texte.

RapidoWrite est un freeware de Ap-
p4Mac (éditeur de PiquantMenu et de 
KidsBrowser, entre autres).

Attention, pour que ce logiciel puisse 
correctement fonctionner, il doit se trou-
ver dans le dossier des Applications.

Rapido semble inopérant avec Mail.

www.app4mac.com

Insérer du texte à la volée

o

Entrez le raccourci, validez, le texte associé s’écrit aussitôt.

C’est dans ce panneau que vous devez définir 
les raccourcis.

Scilabique
ONNAISSEZ-VOUS Matlab ? Non ? Aïe, 
nous voici mal barrés ! Car si vous aviez 
connu Matlab on aurait pu vous dire que 
Scilab, c’était à peu de chose près la 

même chose en version utilisable sans contre-
partie financière.  Maintenant, il nous faut 
entrer un peu dans le détail puisque vous ne 
connaissez manifestement pas. Or donc, Sci-
lab, logiciel développé par l’INRIA (France), est 
une sorte de super calculatrice. Il sait résoudre 
des équations différentielles, afficher des cour-
bes 2D et 3D, etc. Ses points forts sont : – la 
manipulation des matrices et vecteurs de nom-
bres flottants ;  – la programmation en Scilab ;  
– quelques primitives graphiques ;  – quelques 
fonctions importantes pour ces deux domaines 
(génération de nombres aléatoires, résolution 
d’équations...).  Scilab permet de faire beau-
coup d’autres choses, en particulier dans le do-
maine de l’automatique, du traitement du signal, de la simulation de systèmes dynamiques (avec Scicos).  Nous l’avons bêtement 
essayé pour faire des calculs tout cons (5+(65*45)/45), et il y arrive bien aussi, c’est dire.  Scilab qui est porté sous MacOS X en 
application autonome, nécessite la présence de X11. Pour les passionnés, un tutoriel est disponible sur le site Framasoft :

www.framasoft.net/IMG/pdf/ScilabdocA4.pdf
www.scilab.org/
www.lmac.utc.fr/~mottelet/Darwin/

Le signe ~ s’obtient en combinant les touches Alt et N)

c

Scilab s’adresse aux férus de mathématiques.
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Quelle combinaison de caractères ?
Characterpal

 tous les switchers du monde, 
CharacterPal vient d’être adapté au 
clavier Azerty. Il s’agit d’un widget 
destiné à vous aider à savoir quelle 

combinaison de touches utiliser lorsque vous 
souhaitez obtenir des caractères spéciaux.

Placez tout simplement la souris sur le 

caractère désiré, et CharacterPal vous indi-
que comment procéder au bas de la fenêtre. 
Nous devons cette adaptation à PowerMan 
G5, intervenant sur les forums de MacBi-
douille. Alors un grand merci, PowerMan G5 !

F. Giron.

http://forum.macbidouille.com/index.php?act=Attach&type=post&id=3708
http://forum.macbidouille.com/index.php?showtopic=107250&pid=

1339031&st=0&#entry1339031
http://www.apple.com/downloads/dashboard/reference/characterpal.html

à

CharacterPal est un gadget
de Dashboard.

Metasynth

L’autre manière de faire de la musique
L n’y a pas que Garage Band dans 
la vie. Je ne sais pas par où com-
mencer tellement c’est stupéfiant, 

étonnant, abouti .... Metasynth existait 
sous Mac OS 9. Il existe aussi pour Mac 
OS X et uniquement sur Mac (ça c’est 
déjà un argument de poids). Metasynth 
est de niveau professionnel (il y a une 
liste d’artistes qui l’utilisent).  MetaSynth 
sert à « peindre » de la musique.

Et il ne s’agit pas de la courbe 
d’échantillon, mais des notes, c’est com-
plètement différent. On barbouille des 
taches avec les pinceaux spéciaux, on 
écoute, et le logiciel joue des oiseaux sur 
cascade techno. Pour vous faire une idée 
rapide, cliquez sur «Image Synth», puis 
sur la quatrième icône de la barre cen-
trale (en forme de tablette de chocolat), 
puis sur une mini-image au hasard : vous 
venez de charger une «boucle», un «so-
nogramme».

Cliquez sur le haut-parleur en bas à 
droite pour l’entendre. La barre d’Espace 
arrête la lecture.  La marge de gauche 
vous offre les outils pour dessiner de la 
musique sur le sonogramme, celle de 
droite des filtres musicaux que vous ver-
rez agir comme des filtres Photoshop, 
mais que vous pourrez entendre en plus. 
C’est magique. Et tout est intégré pour 
composer, des filtres au séquenceur, en 
passant par les instruments.

Avant de vous précipiter, sachez que 
la Démo pèse dans les 70 Mo toute com-
pressée. Les modes d’emploi et les fi-

chiers d’exemple sont fournis, seules les 
fonctions d’enregistrement sont suppri-
mées. La version commerciale vaut tout 
de même 300 à 600 euros.

Les fonctions d’enregistrement sont 
supprimées, mais on est sur Mac et je 
ne vous en parlerais pas s’il n’y avait pas 
moyen de bidouiller quand même. Rien 
ne vous empêche d’utiliser WireTap pour 
enregistrer vos sons, et Snatcher (gra-
tuit) pour enregistrer vos sonogrammes 
au format PICT. Vous pourrez les rechar-
ger sans problème dans la demo. Vous 

pouvez faire des boucles, des filtres, des 
instruments avec la partie la plus géniale 
de Metasynth, quitte à les monter après 
dans Garage Band.

Comme disait Cavanna : Beethoven 
etait tellement sourd qu’il a cru toute sa 
vie qu’il faisait de la peinture. Il devait 
utiliser Metasynth.

Amiga2U.

MetaSynth n’est disponible que pour Macintosh.

i
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Beholder

 plusieurs reprises nous avons 
évoqué l’existence de Beholder, 
un outil particulièrement effica-
ce pour trouver sur internet des 

images de toutes sortes. Le site internet 
Google.fr propose déjà une fonction de 
recherche par Images. Il suffit d’entrer un 
mot et de cliquer sur Images.  Beholder 
accomplit le même exploit à ceci près qu’il 
ne se borne pas à Google mais sait aussi 
explorer bien d’autres bases d’images. Be-
holder existe en deux versions, la « Lite » 
gratuite et la « Pro » payante (20 $). Avec 

la « Lite » la recherche est déjà tout à 
fait convaincante d’autant qu’aux trois 
sources incluses par défaut (tout le web, 
Google et AltaVista) vous pouvez ajouter 
d’autres bases de clichés.

Déroulez le menu Help>Search en-
gine library pour ouvrir la page web sur 
laquelle vous trouverez d’autres moteurs 
de recherche. Nous vous suggérons de té-
lécharger (cliquez simplement sur l’icône) 
PBase (photos de bonne qualité) et Ditto.

Si vous êtes un amateur d’astronomie, 
sélectionnez aussi le moteur Hubble. Le 
moteur Webshots propose lui des images 
de grande taille et Google Wallpaper vous 
permettra de visionner un tas de fonds 
d’écran.

Une fois que vous avez cliqué sur les 
moteurs de votre choix et qu’ils ont été 
téléchargés et décompressés sur le bu-
reau de votre Mac, ouvrez les préféren-
ces de Beholder et cliquez sur le bouton 
Engines.  Les trois moteurs de base sont 
déjà listés.

Cliquez sur le bouton Import et allez 
rechercher les fichiers téléchargés pré-
cédemment.  Une fois tous les moteurs 
ajoutés, quittez Beholder et relancez l’uti-
litaire pour que les changements soient 
pris en compte. Pour la mise en marche, 
sélectionnez le moteur qui vous intéresse 
et entrez un mot-clé. Un terme anglais 
donnera un plus grand nombre de résul-
tats.

Cliquez à droite sur le bouton Start 
pour démarrer la recherche puis sur ce 
même bouton More pour accroître le 
nombre d’images trouvées. Une fois que 
vous avez trouvé une image à votre goût, 
double-cliquez dessus pour qu’elle s’affi-
che en grand. Pour l’enregistrer, utilisez 
le menu Images>Save image as. L’image 
sera sauvegardée par défaut dans votre 
répertoire Documents. Vous pouvez éga-
lement vous rendre sur le site où a été 
trouvée cette image. Les adresses sont 
indiquées en bas à droite. Il suffit de dou-
ble-cliquer sur les liens.

Mise en garde : ces images ne sont pas forcément libres de droit.
www.mesadynamics.com/beholder.htm

Accéder à la plus grande banque d’images

Cliquez sur les icônes de la page des nouveaux moteurs de recherche. Inscrivez un mot, cliquez sur Start et les images s’affichent.

a

Une fois affichée, l’image peut être sauvegardée.

OURQUOI dépenser des millions de dollars pour passer quelques 
jours dans l’espace quand on peut voir gratuitement la terre ou 
n’importe quelle autre  planète de notre  système en mouvement  
dans la lucarne... de son ordinateur ? OSXPlanet est un petit 

freeware à ravir; conçu par Gabriel Otte, il en est à sa version 0.87. Après 
téléchargement et installation dans le répertoire /Applications, un double 
clic sur son icône révèle un nouveau menu dans la partie gauche de la 
barre de menus ainsi qu’un nouveau fond d’écran; par défaut, ce sont les 
deux hémisphères sombre et ensoleillé de la terre. 

Cependant, un clic sur  le nouveau menu permet d’afficher les préfé-
rences.  Non seulement il est possible d’afficher d’autres planètes, mais 
il est également possible de définir la fréquence de rafraîchissement 

OSXPlanet fait le jour     et la nuit

Prenez un peu de distance par rapport au plancher des vaches.

p
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MindCad Tiler

Imprimer des posters et autres affiches
INDCAD Tiler est un petit 
(320 Ko) logiciel gratuit 
destiné à Mac OS X 
(version minimale requise 

non précisée…) dont l’unique 
fonction est d’imprimer une page 
d’un document PDF sur plusieurs 
feuilles de papier. Par exemple 
pour imprimer une grande affiche 
sur plusieurs feuilles de format 
A4, feuilles que l’on assemble 
ensuite. 

L’interface à base d’icônes est 
intuitive et universelle, ce qui tombe 
bien puisque Tiler n’existe qu’en 
version américaine. Ajustement 
automatique du document au 
format d’impression ou au format 
de page, rotation et défilement 
des pages contenues dans le 
document PDF sont au rendez-
vous. Le format d’impression 
(qui est déterminé par rapport 
aux capacités de l’imprimante 
sélectionnée) est délimité par des 
pointillés gris sur un format de page en 
fond blanc, la prévisualisation est donc 
fidèle.

Il faut juste comprendre que le 
choix d’un pourcentage personnalisé 
d’agrandissement/réduction du document 
(100 % ou autre) s’effectue dans la boîte 
de dialogue du format d’impression : 
menu File > Page Setup.

Tiler sera également très utile à 
tous ceux qui utilisent des traceurs ou 
des imprimantes grand format de par sa 
capacité à agrandir simplement les pages 
d’un document au format sélectionné 
dans le format d’impression.

Tiler gère apparemment les fichiers 
PDF multi-calques (PDF 1.6) créés via 
Adobe Acrobat 7 ainsi que les fichiers 
Photoshop-PDF (PDF 1.4) créés avec 
Adobe Photoshop CS (avec calques de 
réglages). Il ne reconnaît que les fichiers 
au format PDF mais il semble donc 
utilisable avec toutes les versions de ce 
format, y compris les plus récentes.

Seul inconvénient notable : Tiler 
n’ouvre pas les fichiers PDF protégés 
contre l’ouverture par des versions de 
Adobe Reader inférieure à la 6, y compris 
lorsqu’ils ne sont pas protégés contre 
l’impression. Ce qui est quand même 
fort dommage… À l’inverse, l’ouverture 

de fichiers PDF dotés de protections 
destinées aux versions antérieures se fait 
sans difficulté, même s’ils sont protégés 
contre l’impression !

En tout cas ce petit logiciel gratuit et 
efficace comble une fonctionnalité qui 
fait fortement défaut à Adobe Reader. 
Fonctionnalité apparemment basique 
mais forcément payante chez Adobe 
puisqu’elle n’existe que dans Adobe 
Acrobat (depuis la version 6).

J.-R. Boulay.

www.mindcad.com/tiler.php

Cet utilitaire permet d’imprimer un motif en le découpant sur plusieurs pages.

m

www.gabrielotte.com/osxplanet.html

OSXPlanet fait le jour     et la nuit
de l’image - car OSXPlanet suit le 
mouvement de la terre ou des autres 
planètes, des nuages, des satellites, 
etc. Bref, il est plein de ressources. 
On peut également ajouter la, ou 
les, ville(s) de son choix pour qu’elles 
soient visibles. Pour ce faire, il faudra 
en saisir les coordonnées. 

François Giron.

Ouvrez les préférences pour sélectionner une autre planète.
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Petites économies

Omnigraffe

MNIGRAFFLE 4 offre la possibi-
lité de créer ses propres patrons 
(stencil) très facilement car il ac-
cepte une très grande majorité 

de formats (jpeg, pdf, psd,etc...) mais il 
refuse les icônes (.ics) à cause de leurs 
formats spécifiques. Une conversion est 
donc nécessaire.

Pixadex, gestionnaire d’icônes est la 
solution car non seulement, il stocke et 
organise vos collections d’icônes, mais 
par un simple glisser/déposer vers une 
autre application, il transforme automati-
quement l’icône en PDF. Il faudra veiller, 
avant de glisser l’icône, à choisir la taille 
«d’exportation» (fig 1). Le passage vers 

Omnigraffle est donc grandement facilité 
et ainsi vous pouvez créer des «patrons» 
d’icônes, qui vous serviront à illustrer vos 
schémas, tels que ceux que vous décou-
vrirez en parcourant le site d’Atlantic mac 
(fig 2).

Auger.jy pour Atlantic mac

Choisir ici la taille 
d'exportation

Pixadex : gestionnaire d'icônes

Atlantic mac

Stencil

En faisant glisser les icônes depuis 

Pixadex vers le plan de travail

d'Omnigraffle, il y a une 

transformation automatique au 

format PDF.

Le patron 
(stencil) se met 
à jour au même 

moment

Atlantic mac

Importation d'icônes dans un patron (stencil) d'Omnigraffle 4

Créer des patrons avec des icônes

Image 1. Image 2.

o

L’inutilitaire du mois
UR son site web (US uniquement), 
Apple met à disposition des curieux 
une petite calculatrice qui permet de 
calculer les économies engendrées 

par l’activation des options de mise en veille 
automatique de l’écran, du disque dur, et de 
l’ordinateur.

Si le calcul n’est pas particulièrement 
intéressant, les données d’Apple montrent 
toutefois qu’un PowerMac G5 équipé d’un 
écran 20 pouces consomme 70% d’énergie 
de plus qu’un iMac 20 pouces. Quant au G5 
seul, il consomme près de quatre fois plus 
qu’un Mac mini !

J.-B. L.

http://www.apple.com/environment
/resources/calculator.html

s

Cet utilitaire permet de comparer la consommation respective des Mac.
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ES logiciels FTP sur Mac sont 
de plus en plus nombreux, mais 
la plupart sont distribués sous 
forme de shareware : passé un 

certain temps, il faut payer. Si l’outil 
intégré au Finder ne vous convient 
pas et si vous cherchez un logiciel 
tout simple et gratuit pour envoyer 
des fichiers sur un serveur, essayez 
donc ces deux logiciels : RBrowser et 
CyberDuck. Le premier a l’avantage 
de la légèreté, et le deuxième se re-
pose sur la qualité d’un logiciel open-
source.

Dans les deux cas, pas de mauvaise surprise, 
les interfaces sont parfaitement compatibles avec 

MacOS X et avec le glisser-déposer pour plus de 
facilité.

J.-B. L.

Cyberduck-RBrowser

Le FTP gratuit

Cyberduck comme RBrowser sont d’excellents utilitaires de transfert FTP.

l

http://cyberduck.ch/
http://www.rbrowser.com/download.html

Disk Inventory X

Protéger le système en lui donnant de l’espace

ÉRER l’espace disponible du Mac 
est une tâche que vous devez 
avoir à l’esprit continuellement. 
Si votre disque dur manque d’es-

pace, le système MacOS X peut vous 
conduire à la perte de données, voire à 

un plantage monumental. Veillez donc à 
réserver toujours un confortable espace 
dans votre disque système, quelques Go 
n’étant pas un luxe. 

Pour parfaire vos connaissances sur 
le contenu de vos disque durs, vous pou-

vez utiliser un brillant utilitaire 
(donationware) Disk Inven-
tory X créé par Tjark Derlien. 
Ce logiciel, une fois lancé, 
donne sous forme de barres 
bleues, l’espace encore dispo-
nible dans chacun des volumes 
(image 1). Fort bien. 

Une fois un volume sélec-
tionné et ouvert par le bouton 
ad-hoc une nouvelle fenêtre 
s’ouvre après quelques dizai-
nes de secondes de travaux. 

C’est là que Disk Inventory X prend tout 
son sens et devient vraiment passion-
nant.

Tous les éléments sont répertoriés 
sous forme graphique en une fresque 
colorée des plus esthétiques. Cliquez sur 
un élément de ce splendide vitrail et vous 
visualisez aussitôt le fichier auquel il fait 
référence.

Si vous êtes un adepte des logiciels 
installés par Fink, vous constaterez com-
bien le dossier SW est encombrant et 
nécessite un disque dur généreux en 
place.

Une fois les plus gros fichiers repérés 
vous pouvez envisager leur élimination, 
en veillant toutefois à ne pas faire de bê-
tises. 

www.derlien.com/

Le dossier impose un gros disque dur.

g

Éliminez les fichiers avec vigilance.

image 1

DiskInventory présente l’encombrement de chaque disque ou partition.

1er trimestre 2006 - hors série n° 16 - page 19



CLiX

CoverBuddy

La pochette surprise
OVERBUDDY est un shareware qui 
propose une nouvelle manière de 
naviguer dans sa discothèque : 
en sélectionnant la pochette de 

chaque album. On se demande d’ailleurs 
pourquoi iTunes n’intègre pas une telle 
fonction tant elle est appréciable. En at-
tendant qu’Apple ne l’ajoute à son lecteur 
de fichiers musicaux, il faut débourser 
20 ! pour s’offrir CoverBuddy. L’utilitaire 
va d’abord scanner toute votre discothè-
que, sélectionner les images de tous les 
albums et présenter l’ensemble des mu-
siques classées par pochettes. L’incon-
vénient de cet utilitaire est qu’à chaque 
petite modification de votre bibliothèque 
iTunes, il reconstruit sa base, ce qui prend 
plusieurs secondes (selon la taille de votre 
discothèque évidemment). 

Lorsque vous cliquez sur une pochette, 
celle-ci pivote et montre tous les titres de 
l’album. Vous avez le choix ensuite entre 
lire une chanson ou tout l’album.

S’il n’y a pas de pochette associée à 
une chanson, un carré gris « No Cover » 
est affiché qui permet tout autant de jouer 
le morceau. CoverBuddy travaille en étroi-
te collaboration avec iTunes, à tel point 

qu’il crée même une liste de lecture qui 
lui est propre. On peut même piloter la 
musique depuis une console PSP de Sony, 
grâce à ce logiciel. 

www.coverbuddy.com

Écoutez
votre discothèque
comme au bon vieux 
temps, album par album.

c

Vous me ferez 1051 lignes
OUS aimez bidouiller 
Mac OS X. Oh oui. 
Cela ne vous déran-

ge pas de taper de  temps 
en temps une petite ligne de 
commande dans un terminal 
pour améliorer un peu l’inter-
face. Avosmac vous est très 
précieux pour cela. Tous les 
mois, vous tapez systémati-
quement toutes ces fameu-
ses petites lignes. A tel point 
que vous les apprenez toutes 
par coeur pour ne pas avoir 
à les rechercher dans les an-
ciens numéros. Ce temps-là 
est désormais révolu.

CLIX est une application très pratique 
qui contient une mini base de données de 
lignes de commandes pour Mac Os X. Plus 
de mille commandes sont disponibles dans 
tous les domaines via ce logiciel. Il permet 
en plus de les lancer sans rien avoir à ta-
per, ou d’ajouter vos propres commandes. 
Un seul bémol: l’interface est en anglais.

Vous souhaitez montrer à tous vos 

amis cette fonction cachée dans les tré-
fonds du système qu’est le Blob (nom non 
officiel). Vous savez vaguement qu’elle 
concerne Exposé. Installez et lancez CLIX. 
Ouvrer le fichier _categorized.clix, situé 
dans le dossier de l’application. Cliquez 
sur «Category» et faites défiler la fenêtre 
jusqu’à Exposé.

Double-cliquez sur celle qui permet 
d’activer le Blob («enable Exposé blob»). 
La commande, que pourtant vous aviez 
apprise par coeur, était «defaults write 

com.apple.dock wvous-floater -boolean 
true; killall Dock». Mais comment avez-
vous pu oublier ? Cliquez sur «Run». No-
tre ami Blob se lance. Et maintenant, tous 
vos amis vous aiment encore plus devant 
cette maîtrise parfaite de votre félin. Mer-
ci CLIX ? 

Damien Terrier.

CLIX, http://rixstep.com/4/0/clix/

V
Cet outil étonnant propose plus de mille
commandes de Terminal prêtes à l’emploi !
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OUT comme la plupart des navi-
gateurs récents, Safari affiche les 

favicons, ces petites images qui 
apparaissent dans la case d’adresse, ain-
si que devant les signets et les adresses 
du menu Historique... Malheureusement, 
Safari ne met pas à jour ces icônes. En 
effet, si le Webmaster d’un site décide 
de modifier ou de changer la favicon de 

son site, Safari ne la reconnaîtra pas.  
C’est en partie la raison pour laquelle 

Doug Brown, un jeune étudiant améri-
cain, a développé SIM (Safari Icon Ma-
nager) une application Cocoa d’environ 
220 Ko qui ouvre une fenêtre listant tou-
tes les URL et leur favicon dans la partie 
supérieure. La partie inférieure affiche 

l’adresse de l’icône et les différentes pa-
ges web qui l’utilisent.

Une barre d’outils vous permet de 
rafraîchir la liste des favicons, de sup-
primer une ou plusieurs favicons ou de 
vider le cache (seules les favicons seront 
alors effacées, pas les adresses...). Un 
champ de recherche permet de trouver 
rapidement l’adresse d’un site et double 

cliquer sur une adresse charge le site 
web contenant la favicon dans le navi-
gateur. SIM possède une caractéristique 
intéressante : il permet d’attribuer une 
favicon à un site n’en possédant pas par 
simple copier/coller ou glisser/déposer. Il 
vous suffira juste de relancer Safari pour 

visualiser vos modifications.

Safari Icon Manager n’est actuelle-
ment disponible qu’en anglais, cepen-
dant, il est si simple d’emploi que ce dé-
tail ne gênera personne. SIM fonctionne 
avec les versions récentes de Safari mais 
il est également disponible pour les ver-
sions plus anciennes. 

 Joël Barrière.

Manipuler les favicons
SIM

Safari Icon Manager :
http://www.doogul.com/software/sim/

t

SafariIconManager gère et met à jour
les favicons des sites web visités.

Des logiciels à la carte    
cartographie

ES logiciels de cartographie (GIS : Geographic Information 
System) passionnent la communauté des géographes. Il en 
existe plusieurs sur Mac OS X mais la panoplie reste encore 
un peu timide au regard des attentes des utilisateurs. 

• Panoply est un petit soft java gratuit, réalisé par la NASA 
pour piloter des données météorologiques (ou tout autre type 
de données géographiques) à l’échelle mondiale avec différents 
types de projections.

www.giss.nasa.gov/tools/panoply/

• RasterChart2BSB  : Application multiplateforme libre 
permettant de géoréférencer des cartes marines scannérisées 

et de les convertir au format BSB, format lisible par la plupart 
des logiciels d’aide à la navigation du marché. Le site propose 
une liste de logiciels de navigation pour la plaisance compatible 
MacOS X et Linux.

http://pierre.elissalde.online.fr/SiteJustmagic/
RasterChart2BSB.html

• Quantum GIS (ou QGIS) : Permet de visualiser des tra-
vaux réalisés sous MapInfo. Il est capable de gérer, d’analyser et 
d’afficher des données issues de bases géographiques. Compa-
tibles avec les formats : GeoTIFF, Arc/Info ASCII GRid et USGS 
ASCII DEM.

www.qgis.org/

Le nombre de logiciels de cartographie est encore limité. Panoply est gratuit.

l
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Data rescue

e

Tarif : 109 ! en ligne et 119 !
www.prosofteng.com/

www.tri-edre.com/download/download/downloaddataresc.html
www.tri-edre.com/fr/products/productdatarescu.html

Récupérer des éléments effacés

Cliquez sur l’un des boutons pour lancer la recherche des éléments effacés. Une liste d’éléments récupérables s’affiche. A vous de trier.

NFER et damnation ! Vous venez 
de vider la Corbeille de votre ordi-
nateur et constatez qu’un précieux 
document est parti dans les égouts 

en tirant la chasse !  Comment le récu-
pérer ? 

Si vous n’avez pas pris un minimum de 
précaution avant d’appuyer sur le bouton, 
vous aurez peu de chance de récupérer le 
fichier évaporé. En revanche si vous avez 
eu la bonne idée de télécharger et de dé-
marrer le logiciel Data Rescue de Prosoft 
(qui intègre désormais les fonctions de 
Data Recycler X, cf Avosmac n°34 p.17) 
vous pourrez sans doute remettre la main 
sur le précieux document. 

Notez que même la version de dé-
monstration vous aidera puisque sa limi-
tation est de ne vous permettre de récu-
pérer qu’un seul fichier. Quand on en perd 

qu’un, c’est bien pratique, il faut l’avouer. 
Data Rescue présente un panneau de 

cinq boutons : Examen rapide, Examen 
approfondi, Examen contenu, Examen 
enregistré et Démarrer.

Cliquez sur un bouton d’examen puis 
sur le bouton de lancement et patientez 
quelques minutes. Selon l’option choi-
sie (rapide, approfondi, contenu) Data 
Rescue va analyser chaque bloc, chaque 
secteur de votre disque dur et dénicher 
les éléments effacés depuis son premier 
lancement.

Notez qu’il faut pouvoir démonter 
(éjecter) le volume si vous faites une re-
cherche approfondie ou sur le contenu. 
Ce qui implique de pouvoir démarrer sur 
un autre volume pour explorer le contenu 
du disque système.

Dans la liste qu’il vous affichera, vous 
pourrez récupérer un élément de moins 
de 500 Ko (avec la version de démonstra-
tion) ou bien tous les éléments quel que 
soit le poids avec la version payante. 

Vous constatez sans peine combien cet 
outil peut rendre de fiers services même 
si, sous Tiger en tout cas, il peut parfois 
manquer d’efficacité. Nos tentatives de 
récupération de fichiers vidéo téléchargés 
puis effacés depuis quelques jours ont 
toutes échoué. 

Gros regret aussi, distribué par la 
société française Tri-Edre, Data Rescue 
coûte plus de 100 ! (100 $ chez Prosoft). 
Ce qui implique d’en avoir vraiment une 
réelle utilité et d’être particulièrement ma-
ladroit… ou enquêteur de la section anti-
cybercriminalité.

Avec de la chance, le fichier que vous avez effacé
par inadvertance sera récupérable.
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Toast titanium 7

La boîte à outils de la gravure
I vous ne devez posséder 
qu’un logiciel commercial, 
c’est celui-ci qu’il faut ache-
ter. Toast Titanium 7. Cer-

tes, direz-vous, Mac OS X embarque 
déjà tout le matériel nécessaire pour 
réussir à graver. De surcroît, il exis-
te une floppée d’utilitaires plus ou 
moins performants et conviviaux qui 
travaillent fort bien. 

Mais avec Toast, vous n’aurez 
pas à vous poser de question, il 
sera à coup sûr capable de pren-
dre en charge vos données pour les 
graver. D’autant qu’il n’est pas livré 
seul. Toast est accompagné de plu-
sieurs outils tels que « Toast it » et 
«  ount it » deux éléments de menu 
contextuel qui permettent d’activer 
la gravure d’un élément par simple 
CTRL-clic. L’achat de Toast donne 
aussi droit à l’utilitaire Déjà Vu, un 
excellent outil de synchronisation et 
de copie de sauvegarde doté d’un 
grand nombre de paramètres addi-
tionnels. Ce n’est pas tout, Toast est 
aussi accompagné d’un décodeur 
DivX qui permet de lire ce type de 
vidéo avec QuickTime. Ce n’est pas 
tout, les outils CD Spin Doctor (ac-
quisition audio analogique), Discus 
RE et Discus RE.ART ainsi que Motion 
Pictures HD (création de diaporamas 
dynamiques à partir de vos photos) 
font partie du voyage ce qui provo-
que du même coup un sérieux embonpoint 
pour l’application. Elle pèse 340 Mo ! 

Que dire de Toast si ce n’est que pour 
Mac, c’est le meilleur outil de gravure. Cet-
te version 7 Titanium, apporte une nou-
veauté de taille, la possibilité de créer des 
DVD-audio, autrement dit, de vrais Music-
DVD avec un encodage des pistes dans 
une qualité bien supérieure au MP3 ou à 
l’AAC d’Apple ! Vous pouvez de la sorte 
créer un DVD musical en conservant les 
qualités des DVD vidéo d’un concert joué 
en 5.1 par exemple puisqu’il sait travailler 
avec le format Dolby Digital AC3. Selon la 
qualité, le Music-DVD pourra contenir entre 
2 heures et 50 heures de musique. Pour la 
vidéo, sachez aussi que Toast inclut toutes 
les fonctions de compression vidéo offer-
tes par l’autre produit vedette de Roxio, 
PopCorn (cf Avosmac n°50 p.20). Vous 
pouvez ainsi, après avoir extrait un DVD 
du commerce sur votre disque dur avec 
l’utilitaire Mac the Ripper (à télécharger à 
part), créer un nouveau DVD qui tiendra 
sur un DVD à graver du commerce.

Qui peut le plus, peut le moins, Toast 
sait fabriquer des CD vidéo (VCD), des Su-
per CD vidéo (SVCD) et des disques vidéo 
DivX et DivX haute définition. Toast est en 
mesure de transformer n’importe quelle 
vidéo en un film au format MUD, celui sup-
porté par les PlayStation Portable de Sony, 
et uniquement par elles ! 

Notez aussi que, grâce à Toast, vous 
pouvez dupliquer un DVD Apple d’instal-
lation de Tiger sur un DVD-R classique ce 
que l’Utilitaire de disque d’Apple est inca-
pable de faire. 

Autre nouveauté, l’onglet Médias per-
met d’accéder directement au contenu des 
supports multimédia. Par exemple, vous 
pouvez lister tous les titres de votre biblio-
thèque d’iTunes et les glisser un à un pour 
créer un CD audio ou pour ajouter du son 
à un diaporama. 

L’onglet Données sélectionné, vous 
pouvez glisser/déposer autant de fichiers 
à graver que vous le souhaitez sans vous 
soucier du poids final,, le logiciel se char-
gera de calculer le nombre de CD et/ou 
DVD nécessaires.

Toast dispose en outre d’un système de 
partage (voir les Préférences) permettant 
aux autres utilisateurs du réseau d’utiliser 
le même graveur pour peu qu’ils disposent 
eux aussi de Toast.

La documentation livrée avec le pro-
duit est aussi détaillée que parfaitement 
didactique même si on peut lui reprocher 
de manquer de copies d’écran (et de cou-
leur). Mais c’est vraiment histoire de trou-
ver à redire. Autre défaut, Toast prend au 
fil des ans de l’embonpoint et il faut lui 
réserver désormais 340 Mo d’espace sur 
le disque dur !

Conclusion : Les fonctions et capacités 
de Toast en font un produit indispensable 
à tout utilisateur de Mac mordu de vidéo 
notamment. Son prix est largement justi-
fié au regard des utilitaires qui l’accompa-
gnent. 

Prix : 110 ! (90 ! pour la mise à jour)

www.roxio.fr
www.roxio.fr/products/toast7/index.html

s

Toat permet de dupliquer les DVD système Apple.

Plusieurs autres utilitaires sont livrés
avec Toast 7.

Toast travaille mieux qu’iTunes pour les CD audio.

L’utilitaire de Disque d’Apple ne sait pas
dupliquer ses DVD système.
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OpenOffice.org

ÉFLEXE pavlovien, à chaque fois 
qu’un ancien utilisateur de PC 
achète un Mac, il panique terri-
blement à l’idée soudaine qu’il ne 

pourrait plus avoir sur sa nouvelle ma-
chine Word, Excel, PowerPoint, bref, tout 
l’attirail de la suite Office de Microsoft. 
Comme chacun sait, en pareille situation, 
il ne faut pas paniquer. 

D’une part, la suite Microsoft Office 
est bel et bien disponible sur Mac avec 
les outils habituels, exception faite du 
système de gestion de bases de données 
Access. Word, PowerPoint, Excel fonc-
tionnent à merveille sur Mac, et savent 
rapatrier, créer, convertir, transférer, tout 
fichier d’un environnement à un autre.

Mais si Microsoft vous file des boutons, il 
existe d’autre part, une suite concurrente, 
libre et open-source, appelée OpenOffice.
or ou OOo. Cette suite 
est loin d’être quantité 
négligeable. Bien au 
contraire. Elle équipe 
de plus en plus 

d’établissements et d’administrations pu-
bliques soucieux, croyez-le, de nous faire 
faire des économies. On ne peut qu’ap-
plaudir.

OpenOffice.org propose, à l’image de 
sa concurrente commerciale, un solide 
traitement de texte, néanmoins dépourvu 
de correction grammaticale, un tableur 
aussi performant qu’Excel, un système 
de création de présentation (équivalent à 
PowerPoint) et des capacités à créer et à 
gérer des bases de données.

Avec la version 2.0 désormais dispo-
nible, OpenOffice.org a fait un grand pas 
vers une plus grande convivialité et sur-
tout, une meilleure prise en main. 

Le logiciel se compose de plusieurs 
sections :

> Création d’un document texte
> Création d’une feuille de calculs
> Mode présentation (diaporama)
> Dessin vectoriel (mise en page som-
maire)
>Base de données

OOo propose aussi la création de do-
cuments HTML wysiwyg (ce que vous 
voyez est ce que vous aurez), c’est-à-dire 
qu’il est inutile de connaître le langage en 
question pour créer des pages web dignes 
de ce nom.

OOo offre un module de saisie de for-
mules mathématiques permettant de vi-
sualiser les formules dans le respect des 
normes.

OOo intègre aussi des fonctions de 
création d’étiquettes ou de cartes de vi-
site.

Dans tous les cas, OOo peut aller pui-
ser dans une base de données que vous 
avez créée, des informations, et les ajou-
ter à des formulaires composés par vos 
soins afin de les personnaliser. Voici, page 
suivante, un exemple qui vous permettra 
de saisir le fonctionnement des bases de 
données et du mode dessin.

Pour installer ce logiciel, il faut que 
l’utilitaire X11 soit présent dans les Utili-
taires (dossier Applications>Utilitaires) de 
Mac OS X.

Pour télécharger la dernière version française d’OOo :
http://fr.openoffice.org/

OpenOffice en français et en version 2 :
http://fr.openoffice.org/about-downloads.html#fr

NeoOffice, le clone fait la java
L existe une alternative à OOo : NeoOffice. Ecrite en java, 
cette suite bureautique est disponible en français. La ver-
sion 1.1, sortie en juin 2005, première version officielle de 

NeoOffice/J, est basée sur la version stable d’OpenOffice 1.1.4, 
ce qui n’est pas de la toute première fraîcheur. L’un des avan-
tages de cette variante par rapport à OOo c’est sa meilleure 

intégration au système MacOS X. Ainsi, 
la fermeture du dernier document ne 
quitte pas l’application contrairement à 
ce qui se passe avec OpenOffice.

D’autre part, OpenOffice a besoin 
de l’utilitaire Apple X11 pour fonc-
tionner, ce qui n’est pas le cas de 
NeoOffice. Enfin, NeoOffice présente 

un aspect Aqua plus supportable aux yeux des Macmaniaques 
puisqu’il utilise la barre classique des menus pour les principa-
les commandes. NeoOffice présente l’inconvénient d’être lent 
au démarrage. 

r

i

Le système s’installe à partir de Mac OS X 10.2 > 10.4

Le fichier à télécharger pèse 120 Mo (livré avec
les sources) et prendra 330 Mo sur votre disque dur 
au final.

NeoOffice est gratuit.

www.planamesa.com/neojava/fr/

Installez la suite Office sans payer ! 
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NE fois OpenOffice.org version 
2.0 lancé, une page de traite-
ment de texte s’ouvre générale-
ment par défaut. Commencez par 

fermer cette page en déroulant le menu 
Fichier>Fermer (File>Close) (Image 1). 

Puis, toujours depuis le menu Fichier, al-
lez sur Nouveau>Dessin (New>Drawing) 
pour ouvrir une page de dessin vectoriel. 

Si vous souhaitez travailler sur plusieurs 
pages, Utilisez le menu Insertion>Diapo 
(Insert>Slide) (image 2), une nouvelle 
page s’ajoutera à la suite. En l’agrippant 

avec le pointeur de la souris, vous pouvez 
déplacer cette page où vous le souhaitez 
dans la colonne de gauche et modifier 
ainsi l’ordre des pages.

Si vous désirez travailler non pas en 
mode portrait (page verticale) mais en 
mode paysage (page horizontale), utilisez 
le menu Format>Page et cochez le bou-
ton Orientation (image 3) permettant de 
passer d’un mode à l’autre. 

A présent que vous êtes prêt, nous al-
lons créer un bloc texte qui pourra être 
personnalisé. Dans la barre des outils si-
tuée en bas, cliquez sur le bouton T et 
tirez avec le pointeur de la souris dans la 
page blanche pour créer un bloc (ima-
ge 4). Vous pouvez directement écrire 
dans ce bloc ou copier/coller un texte 

provenant d’un autre logiciel. Notez que 
la commande Pomme-V pour coller est 
remplacée par CTRL-V. De même pour co-
pier, il faut combiner les touches CTRL-C 
et pour annuler : CTRL-Z.

Lorsque le bloc contient le texte vous 
pouvez modifier l’aspect du cadre en utili-
sant l’outil Flèche présent à l’extrême gau-
che dans la barre du bas. Placez-vous sur 
les points de couleur verte pour redimen-
sionner le bloc d’un côté et de l’autre. 

Pour ajouter une couleur de fond, cli-
quez sur le bloc pour l’activer et sélection-
nez une couleur dans la barre supérieure 
des outils (image 5).  La couleur des ca-
ractères peut également être modifiée en 
validant cette fois tout (CTRL-A) ou partie 
du texte (avec le pointeur de la souris). 
Enfin, vous pouvez aussi ajouter un cadre 
de couleur différente à ce bloc en utilisant 

les outils Style de ligne et Largeur de li-
gne situés à gauche de la barre d’outils 
supérieure.  

L’insertion d’une image dans ce docu-
ment peut se faire par glisser/déposer (non 
fonctionnel dans la version Mac OS X) ou 
par l’outil « A partir d’un fichier » (From 
file) situé dans la barre inférieure (icône 
formée d’un rond jaune, d’un triangle bleu 
et d’un carré rouge). 

Notez que, contrairement à une page 
de traitement de texte classique, le bloc 
texte et le bloc image sont indépendants, 
ce qui signifie que vous ne pouvez pas in-
sérer l’image dans le texte (image 6) en 
faisant glisser le contenu du texte autour 

de l’image (image 7). Cette fonction est 
en revanche possible dans un Document 
texte, après avoir cliqué sur l’image ajou-
tée, depuis le menu Format>Adaptation 
du texte>Renvoi relatif à la page 

u

image 1

Fermez la page
ouverte
par défaut.

image 2

Cette fonction ajoute une nouvelle page.

image 3

Vous changez ici l’orientation de chaque page.

image 4

C’est avec le pointeur de la souris
que vous créez ce bloc de texte.

image 5

Chaque bloc peut avoir une couleur différente.

L’image ne peut pas être insérée dans le texte.

image 6

Les bases d’une première mise en page
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(Format>Wrap>Page Wrap) (ou autre 
choix selon ce que vous recherchez). 

Pour redimensionner de manière ho-
mothétique une image ou un bloc quel-
conque (conserver les mêmes proportions 
horizontales et verticales), appuyez sur la 

touche Majuscule lors du changement de 
taille à l’aide du pointeur de la souris. 

Chaque bloc peut être déplacé sur la 
page mais peut aussi être placé derrière 
ou à l’avant d’un autre objet. Utilisez les 
outils Disposition (Arrange), Alignement 
(Alignment) disponibles dans la barre 
d’outils inférieure.

Vous pouvez aussi associer plusieurs 
objets en un seul. En appuyant sur la tou-
che Majuscule, cliquez sur un bloc, puis 
sur un autre (voire un 3e, etc) et déroulez 
le menu Modifier>Grouper. Vous pourrez 
faire machine arrière avec la fonction Dis-
socier de ce même menu. Une fois grou-
pés, les blocs sont considérés comme un 
seul objet. Outre les images et les textes, 

il est possible de dessiner des formes (car-
rés, traits, courbes de Bezier, rectangles, 
symboles, flèches, connecteurs, ronds...) 
avec les outils disponibles dans la barre 
inférieure. 

Les documents réalisés en dessin 
vectoriel peuvent être exportés en diffé-
rents formats dont le SVG qui est exploi-
table par Inkscape, Scribus, The Gimp et 
même par Adobe Illustrator. Le PDF est 
évidemment supporté ainsi que le RTF et 
le HTML, ce qui, dans ce dernier cas, peut 
s’avérer bien pratique pour créer de jolies 
pages web.

iPod Viewer

En mode texte, l’habillage est possible.

image 7

E logiciel s’adresse aux propriétai-
res d’un iPod qui ne souhaiteraient 
rapatrier que certaines chansons 
de l’iPod vers leur Mac. Ceci est im-

possible à partir d’iTunes et très laborieux 
«manuellement» (en cherchant dans un 
des 50 fichiers présents sur l’iPod dans 
lesquels les chansons sont placées de ma-
nière aléatoire).  

Si on veut, on peut tout importer, il 
suffit de copier l’iPod (qui se trouve sur le 
bureau), puis de faire glisser le fichier ain-
si obtenu vers la bibliothèque d’iTunes.

Mais c’est plutôt long si on veut ra-
patrier seulement quelques chansons ! Il 
faut alors employer les grands moyens. 
Ici, iPod Viewer est très utile : comme son 
nom l’indique, il permet de «voir ce qu’il y 
a dans l’iPod».

Pour cela, il suffit de cliquer sur 
«Import from iPod» (en haut à gauche 
dans la fenêtre du logiciel). La bibliothè-
que s’affiche alors et il est possible de sé-
lectionner ses chansons.

Pour les copier sur le Mac, il suffit de 
cliquer sur «Set» (en bas à droite), ce qui 
permet de choisir un dossier de destina-
tion, puis sur «Transfer songs» et le tour

est joué ! iPod Viewer permet même de 
lire les chansons (double-clic sur la chan-
son) !

Jérémie Guyomar.

PS : Il existe d’autres logiciels qui ont 
environ les mêmes fonctions, comme 
«Senuti» (mais il est moins soigné et par 
conséquent moins intéressant), ou encore 
iPodRip (payant)...

www.logicielmac.com/logiciel/iPod%20Viewer.html

On sélectionne ses chansons puis on clique sur «Set»...

Rapatrier des chansons de l’iPod vers iTunes

c
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Codebook

ACQLite

Il n’y a pas peer que peer
I vous êtes amateur du téléchargement en « peer to 
peer », un système rendu célèbre par la possibilité de ré-
cupérer des chansons sans rémunérer les auteurs et 
donc de spolier les chanteurs, vous connaissez sans 

doute LimeWire.
Cette application de recherche et de téléchargement 

de fichiers partagés par d’autres ordinateurs connec-
tés au réseau internet et utilisant le protocole d’échange 
Gnutella, existe en version gratuite et payante. Son incon-
vénient est d’être plutôt lourde à mettre en œuvre. Il existe 
une application gratuite plus légère et réactive : ACQlite. Utili-
sant le même protocole d’échange de fichiers, ACQlite est aussi 
performant pour trouver des fichiers mais moins abouti en ce 

sens qu’il ne permet pas, en amont, de sélectionner le type de 
fichier : musique, vidéo, images, etc. Il est en revanche possible 

de le paramétrer pour que les musiques s’importent direc-
tement dans iTunes, ou dans un dossier spécifique selon le 
type.

ACQlite permet aussi de récupérer des logiciels. L’uti-
litaire sait aussi de mettre à disposition de la planète 

des musiques ou autres œuvres dont vous êtes l’auteur 
grâce à la fonction Partage. Il suffit de sélectionner le ou 

les répertoires dont vous souhaitez partager le contenu. 

http://acqlite.sourceforge.net/

s

Comme son nom l’indique, elle dit où vous êtes. Une fois téléchargés, les fichiers peuvent aller
se ranger dans les bons dossiers.

La fonction Partage vous permet de distribuer
vos œuvres.

ACQLite est moins pointu que LimeWire, mais il est plus véloce.

Le livre magique
Mac OS n’est pas une plate-

forme réputée pour les jeux... Il 
en existe pourtant plusieurs cen-
taines ! Il faut savoir que la ma-

jorité des jeux possèdent des astuces, des 
raccourcis cachés, des œufs de Pâques et 
autres conseils judicieux... Une petite ap-
plication, que tout joueur digne de ce nom 
se doit de posséder, regroupe et répertorie 
toutes ces astuces. C’est la Bible des Mac-
gamers : Codebook.

Codebook affiche la liste de tous les 
jeux dans une zone de texte située dans la 
partie gauche de la fenêtre. Cliquer sur un 
jeu dans la liste fait apparaître sous cette 

liste, les différentes catégories d’astuces. Il 
suffit alors de sélectionner une de ces caté-
gories pour voir apparaître les astuces cor-
respondantes dans la zone de texte située 
à droite dans la fenêtre. Un large bouton 
présent dans la partie inférieure permet le 
plus souvent, de vous rendre sur le site de 
l’éditeur ou du développeur du jeu (prati-
que pour les mises à jour).

Sous la barre de titre, un champ de re-
cherche aide à trouver rapidement un jeu. 

Fini les recherches interminables sur 
internet pour savoir com-
ment avoir les vies infinies, 
passer au tableau suivant, 

trouver la clef qui ouvre une porte ou un 
coffre... 

Si vous trouvez une astuce non réperto-
riée ou si vous avez des commentaires, des 
questions ou des idées pouvant faire évo-
luer Codebook, vous pouvez vous connecter 
sur les forums (en anglais seulement...).

Codebook est un shareware à 15 $ mais 
il est pleinement fonctionnel. Indispensa-
ble, donc...

Joël Barrière.

Site web de Codebook : http://www.codebook.se/osx/
Forums Codebook : http://www.codebook.se/osx/forum/

m
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MacTracker

C’est pas sorcier !

La vulgarisation scientifique à portée de clic

RED et Jamy, vous connaissez ? Ces 
deux journalistes de France 3 ont 
lancé il y a plus de dix ans l’émission 
« C’est pas sorcier ! », un exemple 

de didactisme sans nul autre pareil. Ces 
deux gars-là sont des héros nationaux 
tant ils apportent aux jeunes. Sans se 
prendre la tête, avec des bricolages aussi 
astucieux que réalisés parfois avec trois 
bouts de ficelle, le duo de choc bien servi 
par une équipe de techniciens, est une 
bénédiction dans un paysage audiovisuel 
pollué de Star Ac et autres Pop Stars. 

Le concept est si génial qu’il valait bien 
un jeu, ou plutôt un programme éducatif 
de vulgarisation scientifique. Voici qui est 

fait grâce à l’édi-
teur de jeux vidéo  
MindScape (Grai-
nes de Génie, 
Adi, Lapin Malin, 
Adibou, etc), 

le n°1 du marché 
des logiciels pour enfants. 

Compatible Mac (10.2 minimum) et PC, 
« C’est pas sorcier !» s’adresse à toute 
la famille. Le premier titre de la collection 
« Mystérieuse disparition en Amazonie » 
entraîne l’explorateur que vous êtes aux 
côtés de Fred et Jamy modélisés en 3 di-
mensions à la recherche de Paul Rostand, 
un photographe protecteur de la planète 

qui a disparu en pleine jungle.  Sous un 
prétexte ludique le joueur mène une en-
quête ponctuée d’expériences et d’analy-
ses d’indices. Au fil du parcours, le joueur 
acquiert des connaissances multiples 
dans de nombreux domaines avec comme 
fil rouge la forêt primaire d’Amazonie, la 
photographie, les montgolfières, les cher-
cheurs d’or, la cartographie, les Amérin-
diens, etc.

La documentation fournie est sommai-
re. Mais les explications données à l’écran 
sont largement suffisantes.

Prix : 35 !
www.mindscape.com

Fred et Jamy
nous aident
à mieux
comprendre
la vie.

f

Tout sur tous les Mac
UE vous achetiez une nouvelle 
machine ou que vous souhaitiez 
explorer les caractéristiques d’an-
ciens modèles, que vous désiriez 

connaître les capacités d’installation mé-
moire maximales ou la date de sortie d’un 
modèle, que vous vouliez en somme tout 
savoir sur l’ensemble des Mac sortis de-

puis l’origine, il vous faut Mac-
tracker. Cet utilitaire n’est rien 
d’autre qu’une base de données 
rassemblant toutes les caracté-
ristiques des machines produi-
tes par Apple depuis la nuit des 
temps. 

La classement est limpide. 
La colonne de gauche liste tou-
te la gamme, et pour chacune, 
à droite, sa déclinaison par tous 
les modèles qui la composent. 

On peut ainsi constater que la gamme 
iBook a connu 16 modèles successifs. En 
double-cliquant sur la ligne qui correspond 
à un modèle précis, vous obtenez une fi-
che technique dotée de 5 boutons : Gene-
ral, Memory/Graphics, Expansion/Ports, 
History et Notes. Cette dernière est vide 
puisqu’elle vous est destinée. Les autres 
sont suffisamment explicites pour se faire 
comprendre. Vous pouvez ainsi savoir, par 
exemple, si tel modèle est doté, d’origine, 
d’une carte Airport, et de quel type. Vous 
pouvez aussi connaître la quantité de mé-
moire livrée avec la machine, etc. Tout y 
est, même l’historique du modèle. Mal-
heureusement, tout est en anglais.

Cet utilitaire est disponible pour tous 
les systèmes (même Windows et iPod !).

www.mactracker.ca/

q

Chaque Mac a ses propres
caractéristiques.
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Mise en page

Les outils de PAO

L fut une époque, bien loin de celle 
de l’iPod, où les Macintosh faisaient 
la fortune d’Apple grâce à sa remar-

quable implantation dans les ateliers de 
PAO (publication assistée par ordinateur) 
des imprimeurs et les rédactions de jour-
naux. Le passage à vide de la firme de 
Cupertino a laissé le champ libre aux édi-
teurs travaillant sous Windows. 

Aujourd’hui, heureusement, la gam-
me de logiciels destinés à la PAO est tou-
jours abondante sur Mac.

L’hégémonique Quark XPress s’est 
fait tailler des croupières par InDesign 
d’Adobe. Même la rédaction d’Avosmac 
s’est laissée séduire par les remarquables 
facultés du logiciel professionnel d’Adobe 
qui vaut, au passage, 1000 ! de moins 
que son concurrent direct ! A l’heure de 
compter ses sous, la différence peut être 
décisive. 

Mais pour les bourses 
plates, quels outils utiliser 
pour réussir des travaux 
plus ou moins complexes ? 
Existe-t-il des solutions 
moins onéreuses, sérieuses 
et fiables ? L’essentiel est 
de pouvoir générer des sor-
ties en PDF haute définition, 
ce format universel étant 
supporté par tous les impri-
meurs dans le coup. Il faut 
oublier Word de Microsoft 
dont les productions don-

nent des résultats plutôt aléatoires une 
fois rendues chez l’imprimeur. Un fichier 
Word d’un Mac à un autre varie, et d’un 
Mac à un PC, c’est encore pire !

Passons sur le célèbre PageMaker 
d’Adobe, à près de 1000 ! il ne vaut pas 
InDesign et ne trouvera son utilité que 
pour ouvrir des documents créés il y a 
des années sous ce format, lorsque l’ap-
plication était largement répandue. 

Nombreux sont les inconditionnels de 
Ragtime, une application allemande tra-
duite en français et distribuée par Alsyd. 
Ragtime solo avait le mérite d’être gratuit 
pour un usage exclusivement privé jus-
qu’à ce que Mindscape en assure sa dis-
tribution en France. Mais à 50 !, cet outil 
reste l’un des moins chers du marché. 
L’autre outil de PAO abordable, Pages 
d’Apple livré dans la courte suite iWork 
(avec Keynote) sait lui aussi s’adapter 
pour réaliser des travaux professionnels 
en supportant le CMJN. L’absence de cal-
ques ne l’empêche pas de gérer la su-
perposition d’éléments et de jouer avec 
la transparence.

D’autres applications tentent de s’ins-
taller au dessous des deux ténors à l’ins-
tar de MLayout ou encore de Swift Pu-
blisher. Si ce dernier manque encore de 
nombreuses fonctions (il ne permet pas 
la séparation des couleurs en vue d’une 
impression professionnelle), ce n’est pas 
le cas de MLayout. Compatible avec la 
plupart des documents créés dans XPress 
et susceptible d’importer aussi les docu-
ments InDesign, MLayout est capable de 
produire des PDF pour l’imprimerie 

Reste le petite dernier, Scribus, logi-
ciel libre et gratuit porté par une équipe 
de programmeurs acharnés qui n’a pas 
vocation à rivaliser avec les pros du do-
maine. Il n’empêche, à ce tarif, Scribus 
fait bien plus que de la simple figuration 
dans cette liste non exhaustive d’applica-
tion de PAO.

Scribus assure une séparation couleur 
calibrée et exporte des pages PDF/X3 (la 
norme chez les imprimeurs), prêtes à 
flasher, acceptées sans incident par les 
systèmes prépresse. 

• Quark XPress : 2 200 !
http://store.apple.com/Apple/WebObjects/
francestore/ (rubrique Logiciels à gauche)

• Adobe InDEsign : 1350 !
(320 ! pour la mise à jour)
http://store.apple.com/Apple/WebObjects/
francestore/ (rubrique Logiciels à gauche)

• Adobe PageMaker : 985 !
(160 ! pour la mise à jour)
http://store.apple.com/Apple/WebObjects/
francestore/ (rubrique Logiciels à gauche)

• MLayout de SoftMagic (Corée) : 345 !
www.trias.fr/pr_mlayout.html
www.trias.fr/documentation/MLayout_2.1_fr.pdf

• Ragtime : 870 ! (50 ! pour la version solo)
www.alsyd.com/products/
ProductInfo.asp?pid=1954

• Pages (Apple) : (suite iWork) 80 !
www.apple.com/fr/iwork/

• Swift Publisher : 40 !
www.belightsoft.com/products/swiftpublisher/
overview.php

• Scribus : gratuit (version autonome ou via Fink)
http://aqua.scribus.net/
www.le-radar.com/?articles/scribus_scribuspdf.html

MLayout dispose de nombreux atouts pour un tarif modeste. Scribus est gratuit et loin d’être ridicule.

i

Les outils de MLayout
rappellent la version 4
de Quark XPress.
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Audio et vidéo

Trois outils pour lire
les fichiers multimédia sur Internet

ROIS grands pon-
tes règnent sans 
partage sur la dif-

fusion de multimédia via 
internet dans le monde : 
Apple, RealNetworks et 
une officine de Redmond 
baptisée Microsoft. Les 
autres comptent pour des 
queues de cerise.

La première société, 
Apple, ce ne sera pas une 
surprise pour vous, dif-
fuse sa technologie pro-
pre développée autour 
de QuickTime. Cet outil existe en version 
gratuite (installée à demeure dans tous les 
Mac) et en version payante dite « pro ». 
Il s’agit, dans ce dernier cas, d’un outil 
multimédia appréciable pour manipuler 
les fichiers audio et vidéo. Mais il est loin 
d’être indispensable.

Apple propose également des outils 
pour diffuser de la vidéo sur internet 
(QuickTime Streaming Server, gratuit mais 
nécessite Mac OS X Server).

QuickTime est capable de lire un grand 
nombre de formats vidéo et audio, y com-
pris certains DivX par ajout de modules 
spécifiques si nécessaire.

La deuxième compagnie développe 
son standard rendu célèbre par son 

lecteur RealAudio 
aujourd’hui rebaptisé 
RealPlayer dans la me-
sure où il supporte la 
vidéo. Une version 
payante de ce lecteur 
existe aussi ainsi qu’un 
paquet d’outils pour 
diffuser du multimé-
dia en streaming sur 
internet, c’est-à-dire en continu. RealOne 
Player, le seul lecteur vraiment gratuit de 
la compagnie lit les fichiers de type RAM, 
RM, RA, RPM, etc. Une fois que vous dis-
posez de RealOne, lancez-le et déroulez 
le menu View>Radio pour rechercher et 
vous brancher sur des radios francopho-
nes. Lorsque vous cliquez sur une radio 

qui vous intéresse, un fichier est téléchar-
gé sur le bureau. Double-cliquez dessus 
pour lancer le programme. 

La dernière boutique inonde le monde 
de ses fichiers au format WMA ou WMV 
lisibles par Windows Media Player (existe 
en version 9 pour Mac OS X). Là encore, 
la technologie est disponible pour Mac. 

Une fois que ces trois outils sont télé-
chargés dans votre Mac 
(procédure sans doute 
inutile pour QuickTime, 
déjà en place), sans 
oublier l’incontourna-
ble couteau suisse VLC 
de Videolan.org, vous 
disposez de tout l’atti-
rail pour lire les fichiers 
audio et vidéo du mon-
de entier, à de rares ex-
ceptions.

• Télécharger QuickTime : www.apple.com/fr/quicktime/mac.html
• Extraits de films : www.apple.com/trailers/ (en haute définition !)

• RealOne Player : www.real.com/international/ (aller tout en bas de la page)
• Radio et TV : http://france.real.com/guide/radiotv/
• Extraits de film : http://france.real.com/guide/entertainment/movies/

• Windows Media Player : www.microsoft.com/windows/windowsmedia/fr/player/download/download.aspx

• VLC : www.videolan.org  

t

De nombreuses fonctions
ne sont disponibles qu’en version « pro ».

Regardez bien, c’est écrit en tout petit en bas.

RealVidéo en lecture continue.      QuickTime en image haute définition.     WindowsMediaPlayer pour 
          les WMV et WMA.
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Suppositware

GDISK

Offrez-vous 2,6 Go d’espace libre

OUS êtes à l’étroit avec votre dis-
que dur ? Vous souhaitez trouver 
rapidement de la place disponi-

ble sans verser un sou à quiconque, ni 
acheter un dique dur ? Pas de souci. En 
créant un compte GMail sur Google (n°56 
p.36), vous allez pouvoir disposer d’un 
espace disque de plus de 2,6 Go ! Vous 
pourrez ensuite gérer cet espace avec un 
petit utilitaire : gDisk. 

La première étape consiste à s’ins-
crire pour un compte GMail en saisissant 
votre adresse mail courante et les raisons 
de votre souhait de créer ce compte. 

Soyez ensuite patient en attendant 
la confirmation de la création du compte 
par mail. Lorsque votre compte est va-
lidé, lancez gDisk (réalisé par l’auteur de 
l’excellent CocoaJT) et entrez les para-
mètres de votre compte GMail. Ce disque 
distant fonctionne comme l’iDisk de .Mac 
chez Apple par glisser/déposer, à la dif-

férence près que cet espace alloué est 
gratuit. Enfin, l’auteur vous suggère de 
faire un don, 10 euros par exemple. 

gDisk n’est pas encore très stable et 
n’offre pas toutes les fonctions que l’on 
pourrait attendre de lui : sauvegarde 
des paramètres, barre de transfert, non 
gestion des dossiers, etc. Mais il est déjà 
indispensable pour gérer son espace 
GMail.

GMail fonctionnant sur l’ajout de pubs 
dans les messages nous ne voyons pas 
comment cette habile exploitation de 
l’espace disque de la boite de messagerie 
pourrait être longtemps tolérée par Goo-
gle. Méfiance donc, n’allez pas déposer 
des éléments trop précieux sur ce disque 
virtuel distant.

Création d’un compte GMail : www.invitationgmail.info/
Utilitaire gDisk : http://gdisk.sourceforge.net/

Enregistrez un nouveau compte Gmail.

Ce serait effectivement une bonne idée. Glissez/déposez vos éléments sur cet espace.

V

Cliquez plutôt sur non, vous créerez
les dossiers plus tard.

C’est bien dommage.

Améliorer les performances du réseau
ANS son immense et infinie bonté, Apple propose de-
puis peu un un petit utilitaire qui ne fait rien de visible 
aux yeux (l’essentiel est pour le coeur du système) mais 
qui est censé, sur la réclame, accélérer les performan-

ces lors du transfert de fichiers sur internet. Broadband Tuner 
modifie les réglages de fichiers de configuration en affectant 
une autre valeur aux variables systcl : 

net.inet.tcp.sendspace: 131072
net.inet.tcp.recvspace: 358400
kern.ipc.maxsockbuf: 512000

Il ne fait que ça mais le résultat peut être vraiment significa-
tif, sauf si vous utilisez encore une communication RTC classi-
que pour laquelle l’application de ce patch ne fera rien de bon, 
ni de mauvais. 

Il faut être sous Mac OS X 10.4 (ou plus) pour appliquer ce 
correctif.

www.apple.com/support/downloads/broadbandtuner10.html

d
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PAO

AH voilà c’est fait, la rédaction 
d’Avosmac a sauté le pas. La mise 
en page de la revue des trucs et 
astuces pour Mac est désormais 

réalisée sous InDesign, version CS2.
Après deux mois de prise en main, 

petit tour d’horizon en toute objectivité… 
puisque comme tous les logiciels payants 
utilisés par la rédaction, nous disposons 
d’une version achetée.

D’abord la mauvaise surprise : impos-
sible de récupérer les gabarits et pages 
XPress. InDesign n’ouvre que les fichiers 
de la version 4 du logiciel de mise en page 
de Quark, que nous n’utilisons plus de-
puis l’âge de pierre. Seule possibilité pour 
contourner l’obstacle : repasser vos docu-
ments XPress de la version 6 à la version 
5, puis de la 5 à la 4. Cela impose d’avoir 
conservé toutes les versions d’XPress…

Cette astuce est incontournable pour 
les gabarits. Pour les pages en revanche, 
il y a plus simple : utilisez le PDF. C’est l’un 
des nombreux points forts d’InDesign.

Transformez vos documents XPress en 
un seul PDF puis importez-les dans InDe-
sign avec une grande simplicité.

Sans créer au préalable, contrairement 
à XPress, de bloc image dans la page, un 
simple fichier -> importer et le tour est 
joué. Le curseur se transforme. Cliquez 
alors n’importe où dans votre nouveau 
document InDesign : un bloc se crée et 
le PDF est intégré en une seule opération. 

Cliquez à nouveau et l’importation de la 
deuxième page du PDF est faite, puis cli-
quez pour la troisième, etc.

Au-delà du PDF, InDesign gère glo-
balement mieux l’importation de tous les 
types de fichiers. C’est particulièrement 
vrai pour les documents Excel. Le logiciel 
d’Adobe est capable d’importer un tableau 
en respectant votre mise en page. Mieux, 
le tableau reste éditable dans la page In-
Design !

Autre confort de travail, vous pouvez 
éditer vos propres raccourcis clavier, via 
le menu Edition (figure 1). Si vous avez 
des années de pratiques XPress, InDesign 
vous propose de conserver les même rac-
courcis. C’est tout bête mais ça évite une 
belle perte de temps.

D’ailleurs en matière de gain de temps, 
InDesign est également particulièrement 
séduisant. D’abord grâce au jeu de palet-
tes impressionnant qui permettent d’avoir 
tout à portée de souris. C’est particulière-
ment vrai pour l’alignement de blocs ou 
l’habillage, fastidieux sous XPress et très 
facile dans InDesign (image 2).

Ensuite, le gain de temps passe par la 
mise en forme automatique de blocs, via 
la palette Style d’ob-
jets. Fini la répétition 
des mises en forme. 
Fini aussi le glisser-

déposer de la bibliothèque vers la page. 
Un seul clic et tout prend forme sous vos 
yeux. Épatant (image 3) !

Gain de temps encore avec l’ajuste-
ment automatique des blocs par rapport 
au contenu : une fonction pratique qui né-
cessitait, pour l’avoir dans Xpress, l’achat 
d’une XTension.

Gain de temps enfin dans l’enregis-
trement des fichiers. Qui n’a jamais pesté 
devant son écran en attendant de longues 
minutes qu’XPress enregistre un docu-
ment de plusieurs dizaines de pages ? La 
aussi InDesign s’impose.

Florent Chartier.

b

Cette fenêtre, accessible via le menu Édition -> 
Raccourcis clavier, vous permet de paramétrer 
vos propres raccourcis et vous évite ainsi
d’avoir à apprendre ceux de l’éditeur.

image 1

image 3

image 2

La palette Style d’objet permet de créer des mises
en forme prédéfinies pour des blocs (ombres, couleur 
de fond, épaisseur du cadre, etc.). Un simple clic
et la mise en forme devient ensuite automatique.

L’habillage et l’alignement des blocs
est à portée de souris.

www.adobe.fr

La mise en page plus facile sous InDesign 
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Draw SWF

Calamus SL

La PAO à la sauce allemande
E logiciel d’origine allemande exis-
te depuis 1987 et a commencé 
ses gammes sur Atari ST et com-
patibles. Il est encore à l’heure ac-

tuelle développé sur cet environnement 
(TOS). Calamus est un logiciel profes-
sionnel P.A.O. et a longtemps été l’un des 
rares à intégrer la possibilité de ripper en 
interne les fichiers à destination de l’im-
primerie. Son architecture modulaire lui 
permet de ne charger en mémoire que 
ce dont on a besoin et aussi de proposer 
une version standard très complète, que 
l’on peut enrichir par l’achat de modules. 
Ces derniers peuvent à la fois vous sim-
plifier la vie ou bien permettre à Calamus 
d’accéder à la retouche d’image et à des 
effets épatants (modules Filtre, Paint et 
Merge entre autres) sans devoir faire ap-
pel à des logiciels externes. Le fait qu’il 
n’existe qu’en version TOS oblige, pour 

l’utiliser sur Mac OS (9 ou X), d’en passer 
par un système d’exploitation spécifique 
émulant le TOS. Il s’agit de MagicMac. 
Nous en avons déjà parlé dans nos co-
lonnes. Le prix de cet environnement 
(environ 100 euros) doit donc être ajou-
té à celui de Calamus. Il n’empêche c’est 
une solution que certains Mac-users et 
professionnels ont adoptée. La preuve la 
plus flagrante est que ce logiciel est dis-
tribué (et traduit !) en France par Cybèle 

Maia Communication. Cette société en 
fait d’ailleurs son principal outil de travail 
... sur Macintosh ! Calamus existe aussi 
en version Lite permettant, à un prix très 
modeste, d’avoir accès à un outil perfor-
mant puisqu’il s’agit à la base du même 
logiciel dépourvu de certaines fonctions. 
Seul bémol concernant Calamus : son in-
terface est singulière à l’heure actuelle et 
requiert un temps d’adaptation pour qui 
n’est pas habitué à un fonctionnement à 
base d’icônes et non de menus dérou-
lants.

Calamus SL en version 2006 coûte 
700 !. L’ajout de licence supplémentaire 
est à 100 !. Prix de la mise à jour depuis 
la version 2003 : 40 !.

RayXambeR.

http://www.calamus.net

c

Créer des animations Flash

’ACCORD, comparé aux outils commerciaux comme 
Flash MX de Macromedia, DrawSWF ne permet de réali-
ser que de modestes animations pour votre site internet. 
Mais tout de même, ce logiciel libre de seulement 1 Mo 

pourrait déjà faire le bonheur de bien des concepteurs de sites 
internet en froid avec leur banquier. DrawSWF est indépendant 
du système d’exploitation car rédigé en Java.

Il fonctionne parfaitement sur Mac. Vous pouvez inscrire des 
lignes de textes, des formes géométriques, des traits, et même 
dessiner à main levée. Le résultat s’apparente à un GIF animé 

au format SWF ou même SVG, le format vectoriel du web. Pour 
tester le résultat de vos travaux, il suffit de glisser le fichier 
.DrawSWF vers une page de navigateur internet.

Pour que le fichier final soit au format compatible Flash 
(.swf), utilisez la commande Export puis sélectionnez une vi-
tesse d’exécution et enfin enregistrez. Si vous vous bornez à 
enregistrer sans exporter, la format sera : DrawSWF.

http://drawswf.sourceforge.net

Draw SWF est une simple application java. Les animations Flash faciles à créer peuvent être exportées au format SWF.

d
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X-Plane

Pédagogie

Le monde de Lémo
ESTINÉ aux enfants agés de 5 à 7 
ans, c’est-à-dire aux bambins qui 
passent doucement de la parole à 
l’écrit, le logiciel Lemo est un édu-

catif pur jus. Son environnement n’en est 
pas moins traité de telle sorte que l’enfant 
puisse y trouver du plaisir. 

Une fois la longue et laborieuse ins-
tallation terminée depuis le CD 1, et l’ap-
plication démarrée depuis le CD 2, vous 
voici plongé dans une fiesta d’enfer où les 
lettres de l’alphabet dansent entre elles. 
Bien, et que faire ? 

Le jeu éducatif manque ici notoirement 
d’indications pour comprendre qu’il faut 
cliquer sur un groupe de lettres. A cha-
cune, son aventure. Là encore, ça n’est 
pas dit, mais le clic de souris est l’action 
indispensable pour avancer.

D’un apprentissage à un autre, l’enfant 
est censé « s’appropier la cinquantaine de 
graphèmes indispensables à l’apprentis-
sage du système d’écriture française ».

A l’usage, nous ne trouvons pas cet 
outil très intuitif ni très facile à exploiter. 
Ainsi, nous avons éprouvé quelques dif-
ficultés à coller les consonnes devant les 
voyelles tant la vitesse de défilement était 
importante. Sans doute manquons-nous 
de l’habileté d’enfants de 5 ans... Cette 
application n’en reste pas moins agréa-

ble à aborder et l’on salue au passage son 
originalité en transformant les lettres en 
véritables petits personnages. « L’enfant 
est invité à entrer dans le monde de cha-
que lettre qui se caractérise par un envi-
ronnement visuel et sonore riche choisi en 
fonction de la lettre traitée ».

d

Tout part de la folle farandole des lettres. Chaque graphème est décliné
     dans une sympatique animation.

« Lémo, les bases de la lecture » est un produit Alatrace distribué par Mindscape.
Tarif : 40 euros (Mac Os X 10.2 et Windows)

Prenez l’air !
ES mordus d’aviation ne sont dé-
cidément pas gâtés avec le Mac. 
Très peu de simulateurs de vol sont 
disponibles sur cette plate-forme. 

Nous avons présenté dans le n°50 page 
18 FlightGear un simulateur de vol gratuit 
open-source. Cette excellente production 
est sortie en version 0.9.9 en novembre, 
un an après la précédente mouture. 

Concurrent de cette libre adaptation 
du pilotage d’aéronef, X-Plane de Laminar 
Research est une application commerciale 
vendue en ligne 60 !. Ce logiciel néces-
site un joystick pour pouvoir être utilisé 
et la version de démonstration désactive 
le manche 6 minutes après le lancement 
de l’application. 

Après avoir téléchargé les 550 Mo de 
données (contre 110 Mo seule-
ment pour FlightGear), X-Plane 
se lance depuis l’élément X-Plane 
820. Sans surprise, vous êtes à 
bord du poste de pilotage d’un 
avion de ligne qui nécessite de 
se plonger dans la documentation 
avant de prendre l’air.

Moins rigide dans le concept 
que FlightSimulator, X-Plane per-

met de prendre quelques libertés avec les 
avions pilotés, notamment de faire des 
loopings avec un Boeing 747 !

Le moteur graphique 3D calcule les 
contraintes physiques en fonction de la 
géométrie de chaque avion et transforme 
cette modélisation en un comportement 
dynamique très fidèle. Ce simulateur a 
obtenu la certification de la Federal Avia-
tion Administration (FAA), ce qui signifie 
qu’il peut être utilisé pour la formation de 
pilotes de transport ! Reste qu’il faut déjà 
avoir de solides connaissances en matière 
de pilotage, ne serait-ce que pour com-
prendre la signification des dizaines de 
boutons du tableau de bord. Les amateurs 
d’exotisme pourront survoler la planète 
Mars (photos réelles) ou piloter la navette 
spatiale américaine.

Tarif : 60 ! pour la version complète sur DVD 

http://x-plane.com/
www.fr.flightgear.org/ ou www.flightgear.org/

http://macflightgear.sourceforge.net/

l

A ce stade, il est clair qu’il faut un minimum de notion de pilotage.
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Open Source 3D API for Flash

Sandy

ANDY (nom 
venant de 
« San Di » 
s i gn i f i an t 

« 3D » en chinois) 
est une librairie 
permettant la ma-
nipulation d’objets 
3D pour l’environ-
nement Flash de 
Macromedia. C’est 
un projet Open 
Source disponible 
sous licence GPL 
créé par 3 déve-
loppeurs membres 
de l’équipe de mo-
dération des fo-
rums du centre de 
formation Media-
box.

Cette initiative vient du fait que la 
3D est un peu l’enfant oublié de Flash. 
Beaucoup pensent que Flash n’est pas 
adapté pour cela à cause de sa machine 
virtuelle assez peu performante. Néan-
moins apporter une troisième dimension 
interactive au Web est quelque chose qui 
à séduit beaucoup de développeurs. Mais 
aucun d’entre eux n’a fourni un résultat 
exploitable en raison de l’absence de do-
cumentation et de suivi du projet, ainsi 
que de la difficulté technique de ce genre 
de développement. Le projet Sandy est 
né pour combler ce manque et donner 
à tous la possibilité de créer des anima-
tions 3D temps réel sur Internet.

Cette librairie est développée en Ac-
tionScript 2.0 avec une structure orien-
tée objet se rapprochant de celle de Ja-
va3D. Cette similitude vient du fait que 

l’ActionScript 2.0 est un langage dont la 
syntaxe est proche du Java, et que Ja-
va3D est une librairie ayant déjà fait ses 
preuves en termes d’efficacité et d’ergo-
nomie. Aujourd’hui Sandy est disponible 
en version 0.1 alpha sur www.osflash.
org?=sandy, et son développement est 
stoppé afin de prendre le temps de récu-
pérer les premières impressions des utili-
sateurs, et d’apporter les fonctionnalités 
manquantes dès  la prochaine version.

Sandy est donc le premier projet de 
moteur 3D pour Flash possédant une 
vraie API, une documentation tout en 
permettant dès sa première version de 
faire des choses assez évoluées dont 
voici quelques exemples :

• Créer facilement des objets 
grâce aux primitives déjà intégrées à la 
librairie (Sphère, Cylindre, Boite, Pyra-
mide, etc.).

• Texturer les objets avec diffé-
rents éléments : Bitmap, Vidéo et même 
Webcam.

• Gérer les transformations prin-
cipales des objets (translation, rotation, 
zoom) avec différents effets (élastique, 
exponentiel, cubique, rebonds…), nom-
més Tweens. 

• Système de Skins pour le mode 
de rendu des objets, permettant de créer 
facilement de nouveaux modes de ren-
dus personnalisés.

De nouvelles fonctionnalités sont pré-
vues pour les prochaines versions, ainsi 
qu’un nouveau player et l’AS3 (tout cela 
actuellement disponible en version al-
pha) bien plus performant.

Vous pouvez vous tenir informé du 
développement en consultant notre 
blog :
http://dev.media-box.net/sandy.

Nous remercions Pierre Girard, 
responsable chez Media-Box, de 
nous avoir mis à disposition tous 
les outils de développement néces-
saires.

Thomas Pfeiffer – kiroukou 
Nicolas Coevoet - [ NikO ]
Cédric Tabin – thecaptain

Grâce à ces modules, la 3D devient possible avec Flash de Macromedia.

s

Sandy est développé en Action Script. Un player permet de tester ses créations.
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Abiword Trait. de texte www.abisource.com/

  

Adium X chat  adium.aybee.net/

aMSN  chat  www.cmq.qc.ca/4w/amsn/  

Back@Home Utilitaire  www.versiontracker.com/dyn/moreinfo/ 
    macosx/23136  

BatChmod Utilitaire  http://macchampion.com/arbysoft/  

Beholder Utilitaire  www.mesadynamics.com/beholder.htm

Blender 3D  www.blender3d.org/cms/
   

Celestia Astronomie www.shatters.net/celestia/ 

ClamXav Antivirus  www.macupdate.com/info.php/id/15850 
 

CocoaJT Utilitaire divers http://jeanmatthieu.free.fr/cocoajt/ 

Coloriage autre...  http://cadfael.club.fr/RB/App/coloriage/
    coloriage.html

Cyberduck Client FTP http://cyberduck.ch/

CookiX V2.0 Bases   http://perso.wanadoo.fr/pjgoulier/
  de données REALWORKS/logiciels.html  

Desktop Utilitaire divers http://desktopmanager.berlios.de/ 
Manager 

Abiword est un logiciel open-source susceptible 
d’ouvrir et de générer des documents compatibles 
avec Word de Microsoft. 

Adium est une application gratuite de messagerie 
instantanée pour Mac OS X qui permet de se connec-
ter sur les réseaux AIM, MSN, Jabber, Yahoo, etc.

Messagerie instantanée à la manière de MSN

Utilitaire vraiment très pratique pour sauvegarder 
ou/et restaurer notamment son carnet d’adresses, 
ical, Mail , Keychain. Compatible Tiger .

BatChmod est une application Cocoa qui permet de 
changer les autorisations sur les dossiers et fichiers. 
ll vous permettra également de forcer une corbeille 
récalcitrante à se vider.

Beholder est gratuit dans sa version 1 «lite» et 
payant en version 2. Cet utilitaire permet de recher-
cher sur internet des images dans des bases spécia-
lement dédiées. La recherche s’effectue par mot-clé.

Blender.31.0.html  Blender est un logiciel de modé-
lisation, de rendu et d’animation en 3 dimensions. 
Ce logiciel est disponible pour les plates-formes 
Unix, Windows, BeOS et Mac OS X. Contrairement 
à d’autres logiciels 3D qui peuvent coûter plusieurs 
milliers d’euros, Blender est gratuit. Il est développé 
et maintenu par la société Hollandaise NaN (Not a 
Number) et est livré sans ses sources.

Celestia est un logiciel scientifique d’astronomie et de 
simulation permettant de voyager à travers l’univers 
et l’exploreration des planètes et des étoiles.

Même si il n’y a pas, à ce jour, de Virus sur Mac OS 
X il peut-être parfois utile de scanner son Disque dur 
ou ses Mails, afin de savoir si on n’a pas un virus 
Window qui traîne quelque part ( sympa pour ne pas 
l’envoyer à vos amis «PCistes».

CocoaJT permet de voir en ligne les flux vidéo de dif-
férentes chaînes TV et d’écouter la radio avec accès 
aux archives.

Ce logiciel de dessin pour enfant permet de faire des 
coloriages à partir de dessins au trait noir.

Cyberduck est un client FTP open-source et gratuit. 
Logiciel stable, simple à utiliser et performant.

Un logiciel sympa de gestion de recettes de cuisine, 
avec lequel vous pourrez classer et retrouver vos 
recettes favorites au moyen de sélections multi-cri-
tères.

L’utilitaire gratuit indispensable sous MacOS X, pour 
avoir jusqu’à 9 écrans sur votre Mac, en utilisant un 
seul moniteur. On peut cacher tous ses écrans derriè-
res les 9 touches du pavé numérique et de passer de 
l’un à l’autre avec un contrôle + le chiffre.

Nom  Catégorie Adresse       Commentaire

Freeware : les gratuits de la base avosmac.com
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Dockless Utilitaire divers http://homepage.mac.com/fahrenba/
    dockless/dockless.html 

Easy Find Utilitaire  www.macupdate.com/info.php/id/11076 

Enkoder Utilitaire  http://automaticlabs.com/products/
    enkoderapp

FaxEmail Utilitaire  www.rwts.com.au/faxemailhelper/ 
Helper

Fink  Utilitaire  http://fink.sourceforge.net/  

Fink   Utilitaire  http://finkcommander.sourceforge.net/ 
Commander

Fire  Chat  http://prdownloads.sourceforge.net/fire/

Firefox  Navigateur  www.mozilla-europe.org/fr/ 
  internet

FolderGlance Utilitaire  www.apple.com/downloads/macosx/
    system_disk_utilities/folderglance.html 

Galerie  Web  www.myriad-online.com/fr/ 

GeekTool Utilitaire  http://projects.tynsoe.org/fr/geektool/ 

Gimp  Retouche  http://gimp-app.sourceforge.net/
  d’image 

Gnumeric Tableur  www.gnome.org/projects/gnumeric/ 
 

Grisbi  Comptes  www.grisbi.org/ 

Handbrake Vidéo  http://handbrake.m0k.org/ 

Dockless permet qu’une application active n’appa-
raisse pas dans le Dock.

Permet de chercher (sans indexation) dans le conte-
nu de tous vos dossiers (pratique , voire indispensa-
ble, pour ceux qui n’ont pas Spotlight )

Enkoder cripte l’adresse mail dans votre site internet, 
pour la protéger des automates spameur, tout en 
gardant le lien fonctionnel pour qui veut envoyer un 
mail.

En principe, via les préférences système d’OS X, on 
peut choisir de recevoir les fax par Mail, mais parfois, 
cette option ne fonctionne pas (sous Panther comme 
sous Tiger ) FaxEmailHelper permet de contourner ce 
« bug» et de recevoir tous les Fax par Mail.

Fink, associé à Fink Commander, permet de télé-
charger et d’installer des logiciels open-source issus 
notamment du monde Linux et de les exploiter sur 
Mac grâce à l’utilitaire Apple X11. Avosmac consacre 
une rubrique régulière à la découverte et à l’exploita-
tion de ces logiciels du «monde libre».

Interface graphique permettant d’installer des logi-
ciels open-source via le système Fink.

Logiciel de Messagerie instantanée : AIM, ICQ ,Jab-
ber ,MSN, Yahoo, IRC, Bonjour

Navigateur internet de plus en plus utilisé, Firefox est 
devenu LE concurrent d’Internet Explorer de Micro-
soft. Il a pour lui d’être mis à jour régulièrement, 
d’être parfaitement aux normes du web et de fonc-
tionner sur toutes les plates-formes. Gratuit, Firefox 
est un logiciel open-source.

Plugin qui permet de voir le contenu de son disque 
dur et d’ajouter ses dossiers favoris.

Galerie pour Mac OS X (10.2 à 10.4), crée en quel-
ques clics des pages Web pour présenter images, 
films, panoramas, sons... Galerie travaille de concert 
avec iPhoto, GraphicConverter, iView MediaPro, Ex-
tensis PortFolio 7 ou par glisser-déposer des fichiers.

GeekTool est un module de Préférences système per-
mettant d’afficher sur le bureau du texte, des images 
ou la sortie de commandes de Terminal.

(voir The Gimp)

Pour l’instant uniquement disponible via Fink, Gnu-
meric est un logiciel de calculs (tableur) aux perfor-
mances proches d’Excel de Microsoft, mais open-
source et libre d’utilisation.

Grisbi est un logiciel open-source français qui permet 
de gérer ses comptes bancaires. Grisbi s’installe avec 
Fink. cf Avosmac n°51 p.47

Le logiciel Handbrake permet de convertir et de com-
presser une vidéo au format DivX très aisément.

Nom  Catégorie Adresse       Commentaire
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Hey Folders Utilitaire divers www.bronsonbeta.com/heyfolders/ 

i-Installer Utilitaire  http://ii2.sourceforge.net/  

iBackup Utilitaire divers www.grapefruit.ch/iBackup/ 

iCal FTP Utilitaire divers www.drewfindley.com/
    findleydesigns/products.html 

Image Tricks Retouche  www.belightsoft.com/download/
  d’image  download.php

Inkscape Dessin  www.inkscape.org/download.php
  vectoriel

iTune  Utilitaire divers http://ilari.scheinin.fidisk.fi/
MyWalkman   itunemywalkman/  

iTunes  Audio  www.apple.com/fr/itunes/ 

Kexi  Base   www.kexi-project.org/
  de données

Linotype  Utilitaire divers www.linotype.com/2104-2493-2104/
Font ExplorerX  

LiveQuartz Retouche  www.macupdate.com/info.php/id/18064 
  d’image

LockUnlock Utilitaire divers http://lockunlock.free.fr/  

LookInPod Utilitaire divers http://LookInPod.free.fr/  

Macfreepops Utilitaire divers www.e-link.it/macfreepops/ 

MainMenu Utilitaire  www.macupdate.com/info.php/id/17111 
 

MAMP  Base  www.mamp.info/fr/home/  
  de données

Compléter la colorisation des étiquettes/cartouches 
des dossiers par l’attribution de la couleur aux dos-
siers

i-Installer (version actuelle: 2.69.0) est un logiciel 
d’installation et de configuration. Il permet d’installer 
des packages, particulièrement utilisé pour l’installa-
tion de TeX/LaTeX.

Excellent logiciel pour des sauvegardes (pour Tiger )

Publier et partager des calendriers iCal

Retouche d’images utilisant Core-Image (Tiger)

Inkscape est un logiciel open-source de dessin vec-
toriel (comme Illustrator d’Adobe) disponible via Fink 
ou en version autonome. Il gère le format SVG.

Comme son nom l’indique... gère les listes iTunes 
pour les synchroniser avec un portable Sony-Ericsson 
Walkman ( le K750i est reconnu)
Voir aussi : «SyncTunes» gratuit
www.nesfield.co.uk/synctunes/
ou «Dreamsicle» payant
www.kaisakura.com/dreamsicle.html

iTunes est l’outil le plus simple pour organiser, parta-
ger et écouter votre collection musicale.

Kexi est un logiciel open-source de gestion de bases 
de données dont l’ambition est de pouvoir offrir 
les même fonctions que les solutions commerciales 
proposées par Filemaker Pro ou Microsoft Access, ou 
encore 4D ou Oracle. Kexi peut être installé par Fink.

Excellent manager de Fontes en version ßêta pour 
l’instant, mais très prometteur. À terme risque de 
devenir le meilleur depuis ATM Deluxe sous OS 9.

Superbe logiciel de retouche d’images avec nom-
breux filtres Maintenant en version finale. Tiger.

Utilitaires de Franck Méréo permettant de verrouiller/
déverrouiller un fichier ou tout un dossier par simple 
glisser déposer.

Utilitaire de Franck Méréo permettant de lire et 
d’extraire le contenu audio d’un iPod sans passer par 
l’iTunes qui le contrôle…

Permet de recevoir ses courriers hotmail dans son 
logiciel de Messagerie (dans «Mail» par exemple). Ce 
n’est pas un plugin donc ne peut pas perturber votre 
logiciel de messagerie

Utilitaire pour lancer toute sorte d’opérations de 
maintenance indispensable à la bonne santé de Mac 
OS X, via la barre des Menus (compatible Tiger)

MAMP (Mac Apache MySQL PHP) est une solution 
très pratique pour mettre en oeuvre facilement une 
base de données MySQL et utiliser le langage de pro-
grammation de scripts, PHP. MAMP est un utilitaire 
qui démarre le serveur MySQL et PHP inclus dans le 
pack complet.

Nom  Catégorie Adresse       Commentaire
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menumeter Utilitaire  www.ragingmenace.com/software/
    menumeters/ 

Mercury Chat  www.mercury.to/  

MNS   Chat  www.microsoft.com/mac/default.
Messenger 5     aspx?pid=msnmessenger

mpc2aiff Utilitaire divers http://homepage.mac.com/julifos/
    soft/mpc2aiff/

MyGuide Sites Mac www.jeremysoftware.new.fr/

NVU  Web  http://frenchmozilla.sourceforge.net/nvu/

ohmiGene autre...  www.nauze.com/ 

Onyx  Utilitaire  www.titanium.free.fr/pgs/french.html 

OpenOffice.org Suite  http://fr.openoffice.org/ 
  bureautique

Photodesktop autre...  http://photodesktop.alwintroost.nl/ 
 

Postcards autre...  www.raggers.net/pathos/postcards.php 

Qemu  autre...  http://  

RapidoWrite Utilitaire divers www.app4mac.com/french/index.php? 
    action=item&id=13 

RCDefautlApp Utilitaire  www.macupdate.com/info.php/id/14618 

Scilab 3.1.1 Utilitaire divers www.lmac.utc.fr/~mottelet/Darwin/ 
 

Scribus  PAO  http://aqua.scribus.net/  

SimpleViewer Web   www.airtightinteractive.com/simpleviewer/ 

SizzlingKeys Utilitaire divers http://yellowmug.com/sk4it/ 

Petit utilitaire permettant sur la barre des menus se 
visualiser, le taux d’occupation de CPU, les vitesses 
de chargement et téléchargement, bref en plus d’être 
indispensable, il est indispensable

Logiciel de messagerie qui permet d’utiliser une    
webcam entre Mac et PC avec tous ses contacts 
MSN. Prend beaucoup de ressources CPU avec la 
fonction vidéo, mais ça marche .....

Logiciel de Messagerie de Microsoft ( toujours pas la 
vidéo ) mais quelques nouveautés par rapport à la 
version précédente.

Convertit par simple glissé déposé le format audio 
mpc en aiff

Une fois installé, permet d’avoir les liens de tous les 
sites internet consacrés au Mac.

NVU est un logiciel de conception de pages web en 
langage HTML wysiwyg (vous n’avez pas de lignes 
de codes à entrer). NVU supporte les feuilles de style 
CSS. 

OhmiGene est un logiciel (gratuit) de Généalogie 
pour Mas OS X.

OnyX est un utilitaire d’optimisation, de maintenance 
et de personnalisation.

OpenOffice.org est la suite bureautique de plus en 
plus utilisée en lieu et place d’Office de Microsoft. 
OOo rassemble les mêmes fonctions (traitement 
de texte, dessin vectoriel, feuille de calculs, etc) et 
présente les mêmes compatibilités.

Freeware qui permet d’assembler plusieurs photos, 
comme sur un album, de façon à les voir toutes en 
même temps sur le Bureau. Les photos utilisées sont 
encadrées et peuvent avoir un nom

Application qui permet d’envoyer une carte postale 
électronique ( avec vos propres photos ) à vos amis 
ou à votre famille , tout ça de manière rapide et 
simple.

Emulateur gratuit

Insertion automatique de phrases fréquemment 
utilisées dans n’importe quelle application

Préférence panel qui permet, notamment , de choisir 
son navigateur par défaut, son logiciel de messagerie

Scilab et l’équivalent open-source de Matlab. La 
version de M. Mottelet est double clicable (celle du 
29 août 2005).

Désormais disponible en version autonome sur Mac 
(ou bien par Fink), Scribus est une application qui 
permet de faire de la mise en page (PAO).

Création de galeries photos sur site perso

L’utilitaire le plus rapide au monde pour contrôler iTu-
nes par raccourci clavier. On peut jouer, arrêter, pas-
ser au suivant/précédent, présentation du morceau, 
classer, … et même bloquer l’écran avec login.

Nom  Catégorie Adresse       Commentaire

1er trimestre 2006 - hors série n° 16 - page 39



Nom  Catégorie Adresse       Commentaire

Stellarium est un logiciel d’observation du ciel en 
temps réel.

Navigateur internet dont certaines fonctions sont 
destinées aux administrateurs de sites internet.

Si vous n’avez pas de ROKR mais un Sony-Ericsson 
K750 ou W800 ou autres (à tester) SyncTunes peut 
vous aider à synchroniser iTunes et votre portable.

Ce logiciel de retouche d’image très puissant est 
disponible en version autonome sur Mac. Il peut être 
aussi installé via le système de portage Fink.

Thunderbird est un logiciel de messagerie électroni-
que concurrent d’Entourage de Microsoft (et d’Out-
look Express) ou encore de Mail d’Apple. Open-sour-
ce et gratuit, Thunderbird dispose d’outils de lutte 
contre le spam plutôt efficaces.

Utilitaire permettant d’optimiser MacOSX, graver des 
CD/DVD, obtenir des informations sur sa configu-
ration réseau, lancer des scripts de maintenance et 
la reconstruction des autorisations sur des postes 
distants…

Twain-Sane peut être installé par packages. Il per-
met de piloter la plupart des scanners du marché 
depuis des applications comme The Gimp, Graphic 
Converter, etc, même ceux dont les pilotes ne sont 
pas disponibles sous MacOS X. Voir aussi : XSane cf 
Avosmac n°52 p.44

Distribution Linux pour Mac disponible en CD ou DVD 
d’installation ou en Live CD. Téléchargement gratuit.

Lecteur multimédia complet (sans installation de 
codecs). Il lit (pratiquement) tous les types de for-
mats (MPEG-1, MPEG-2, MPEG-4, DivX, mp3, ogg, 
etc.) mais aussi les DVD, les VCD & certains types 
de flux réseau (MPEG2 TS en UDP ou des paquets 
HTTP unicast ou multicast en réseau IPv4 ou IPv6). 
Incontournable !

Logiciel d’échange de fichiers et de chat en mode 
client serveur 

Xephem est un puissant logiciel d’astronomie, 
peut-être le plus puissant, tous systèmes d’exploi-
tation confondus, pour un usage d’amateur avancé. 
Xephem intègre une fonction Seti@Home et permet 
même le pilotage d’un télescope branché sur l’ordina-
teur. » S’installe avec fink http://logiciels-libres-cndp.
ac-versailles.fr/article.php3?id_article=88

XSane peut être installé via Fink. Il permet de piloter 
la plupart des scanners du marché, même ceux dont 
les pilotes ne sont pas disponibles sous MacOS X. 
Voir aussi : Twain-Sane cf Avosmac n°52 p.43

Grâce à ce plugin, Spotlight va pouvoir chercher dans 
les dossiers au format zip

Stellarium Astronomie http://stellarium.sourceforge.net/index.html 

Sunrise  Navigateur  www.sunrisebrowser.com/fr/ 
Browser internet

SyncTunes Utilitaire divers www.nesfield.co.uk/synctunes/  

The Gimp Retouche  http://gimp-app.sourceforge.net/  
  d’image

Thunderbird Messagerie www.mozilla-europe.org/fr/
    products/thunderbird/ 

ToolsX  Utilitaire divers http://toolsx.free.fr/hometoolsx_french.php 
 

Twain-Sane Utilitaire  www.ellert.se/twain-sane/

Ubuntu  Linux  www.ubuntu-fr.org/

Video Lan -  Utilitaire vidéo www.videolan.org/vlc/  
VLC media
player

Wired client autre...  www.zankasoftware.com

X-Ephem autre...  www.clearskyinstitute.com/xephem/

XSane  Utilitaire  www.xsane.org 

Ziplight  Utilitaire  www.macupdate.com/info.php/id/19026
Spotlight
plugin
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% fink install ispell

% fink install ispell-french

% ispell -d francais fichier.txt

0-n

R

A

?
Q

;;===========================
;; pour avoir le dictionnaire français
;;===========================
(setq ispell-dictionary "francais")
(setq ispell-dictionary-alist

'(("francais" "[A-Za-
zÀÂÇÈÉÊËÎÏÔÙÛÜàâçèéêëîïôùûü]" 
"[^A-Za-zÀÂÇÈÉÊËÎÏÔÙÛÜàâ-
çèéêëîïôùûü]" "[-']" t

("-d" "francais")
"~list" iso-8859-1))

)

M-x ispell-change-dictionary
RETURN francais RETURN

M-x ispell-minor-mode RETURN

François Giron.

Une bonne correction

p
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Installer un nouveau navigateur aux commandes

-> http://gthumb.sourceforge.net/

Gthumb à genoux devant
ce gestionnaire d'image

d
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-> http://gramps-project.org/

La généalogie via Fink

e

Mac OS X Install
DVD/System/Installation/Packages/

www.apple.com/support/
downloads/x11formacosx.html

Où trouver X11 ?
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courrier
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« Tout d’abord, bravo pour la refonte 
de la mise en page, c’est beaucoup plus 
clair, lisible et confortable, en plus c’est 
très joli ! Cette mise en page met bien 
plus en valeur le contenu passionnant de 
vos articles. 

Un seul truc me chagrine, alors 
que vous lancez le nouveau magazine 
«OpenSource Mag» (que je n’ai toujours 
pas trouvé en kiosque d’ailleurs), vous 
avez purement et simplement supprimé 

la rubrique X11 d’Avosmac. Pourquoi ? 
Est-ce pour inciter vos lecteurs à acheter 
OpenSource Mag ? (ce que je compren-
drais, il faut bien vivre !) En tout cas, je 
trouve ça quand même dommage ! »  
Ronan, lecteur régulier d’AvosMac

Avosmac : Le numéro que vous tenez 
entre les mains prouve que cette rubrique 
« X11 » n’a pas disparu d’Avosmac. 

Nous n’avons nullement l’intention de 

négliger les logiciels open-source dispo-
nibles sous Mac OS X, bien au contraire. 
Quant à Opensource-Magazine, il s’adres-
se aux utilisateurs de Mac qui souhaitent 
utiliser toutes les ressources open-source 
soit dans Mac OS X soit dans une distribu-
tion Linux, notamment Ubuntu, l’une des 
plus faciles à aborder.

www.opensource-magazine.com

Un truc qui chagrine

J’ai un Caméscope Canon MV600 depuis trois ans. Il fonctionne très bien et j’ai fait 
de nombreux montages avec iMovie & FCP. Jusqu’au 15 octobre, j’avais un DD FW 400 
(laCie 120) pour le stockage vidéo. J’ai acheté un deuxième DD (LaCie160 extrême) FW 
800 afin d’utiliser mon port 800 vide.

Lors de ma première capture : le Canon MV800 n’était plus reconnu... ni iMovie, 
FCP, iChat, rien.

J’ai tout essayé (préf etc.). J’étais sur le point de conclure à une panne du Canon. 
Je l’ai testé sur un PMG4 d’un ami : au poil, comme avant.

Retour sur mon PMG5 1,8X2 et 10.3.9 (ainsi que Tiger sur DD externe) Niet !
J’arrête, je débranche le FW800, je relance..... et tout remarche !
Pire : je re-connecte le FW800, mais je branche le Canon et je l’allume (en vcr pour 

capture) : je démarre. Le DD interne monte, mais aucun des deux DD  FW 400 & 800!
Je coupe le Canon et débranche le câble : les deux FW s’affichent instantanément 

comme un bouchon qui monte à la surface.
Mon Canon est sur la liste des compatibles et d’ailleurs je l’utilise depuis longtemps 

sans problème. Avec Panther ou Tiger : idem
Quelqu’un peut-il m’expliquer pourquoi une connexion FW800 empêche la recon-

naissance du Canon (Nb: iSight avec ou sans 800 fonctionne) ? Jean-Louis Chaussier.

Leçon du Canon
Qu’est-ce qu’un «modèle récent ? Le 

truc en question (AVM n° 56 page 11) 
fonctionne sur mon iMac G4/700 (OS X 
10.3.9), sur l’iMac DV 450 (G3) de mon 
fils (10.3.9 aussi), et sur mon PowerBook 
G3/233 sous 10.2.8, il le fournirait aussi 
s’il était dispo (là, je n’ai que la version et 
le «build», mais le N° de série n’est pas 
dispo non plus depuis Informations sys-
tème Apple, ce modèle n’ayant pas l’Open 
Firmware).

En fait, ce truc fonctionne sur tous les 
Mac «OpenFirmware» (donc depuis les 
premiers iMac, en gros) sous OS X 10.2.8, 
et même sûrement (mais là je ne peux pas 
vérifier) sur des OS X plus anciens. Voili 
voilou. Pascal.

Vieux modèle récent

J’ai téléchargé SideNote - comme écrit dans Avosmac n° 56, page 19. Au début 
j’avais une bonne impression de ce logiciel. J’ai enregistré beaucoup d’informations 
mais je n’ai plus accès à l’utilitaire. Car j’ai modifié les réglages d’opacité et désormais, 
SideNote ne se voit plus tant il est transparent. Que faire pour remettre la main des-
sus ? John Vonk.

Avosmac : Effectivement, une fois le degré d’opacité réglé sur 0 %, SideNote est 
toujours présent sur l’écran mais il est impossible de le voir. Si vous le quittez, et vous 
pouvez le faire soit en relançant la session (si vous l’avez ajouté à l’ouverture de session 
dans Comptes, retirez-le), soit depuis le Terminal en entrant la commande :

killall sidenote

Mais à son prochain démarrage, SideNote sera toujours invisible. La seule solution 
est de supprimer l’élément :

org.chatelp.Sidenote.plist

qui se trouve dans votre Bibliothèque>Préférences
Le plus triste dans l’affaire, est que vous perdrez toutes vos petites notules. Alors ne 

jouez plus en toute transparence ! 

La transparence n’a pas que du bon !

Attention à ne pas trop travailler
en transparence.



courrier

« Grâce à vous (n° 54), j’ai appris qu’il 
y avait des séries défectueuses de iMac 
G5 et ai pu constater que j’avais un nu-
méro gagnant ! J’ai ainsi compris le pour-
quoi des innombrables « Kernel panic » 
qui, peu à peu, sont devenues troubles et 
tremblotantes jusqu’au plantage complet 
et définitif !

J’ai déposé la bête (sur les conseils 
du service assistance Apple contacté par 
téléphone) à IC informatique-Toulouse et 
il m’a été demandé 60 ! (HT) de frais de 
dossier (?) vu que je n’avais pas acheté 
l’appareil chez eux. (Mon vendeur s’était 
contenté de me faire une réinstallation 
du système (facturée 40 ! HT quand 
même !) qui s’est finalement avérée 
inopérante ! Après un séjour d’un mois 

à Toulouse, ma machine vient d’être 
récupérée mais je constate les anomalies 
suivantes :

- impossible d’obtenir la page accueil 
«Safari» (donc pas de Google), l’applica-
tion s’ouvre mais l’écran reste vierge.

- impossible d’ouvrir les liens de mes 
mails (je n’ai donc pu valider mon inscrip-
tion à vos forums et c’est pourquoi je vous 
adresse ce message).

- impossible d’utiliser les clés USB dont 
l’icône n’apparaît plus sur l’écran.

J’espère que c’est tout ! Je ne sais 
plus que faire et en désespoir de cause, 
je vous lance cet appel en espérant que 
vous pourrez me donner de judicieux 
conseils. D’avance, je vous en remercie. » 
zygomac.

Avosmac : A ce stade, si votre ordi-
nateur a été réparé sur le plan matériel, il 
semble que son périple à Toulouse ait en-
gendré un peu de pagaille.

Vous pouvez travailler sur votre réper-
toire de Préférences en mettant de côté 
l’ancien.

Vous pouvez aussi créer un nouveau 
compte et rapatrier les éléments indispen-
sables depuis le compte inopérant. Vous 
pouvez enfin sauvegarder vos données 
(dossier Utilisateurs) et refaire une installa-
tion complète et propre de votre système. 
Nous vous suggérons de consulter le n°52 
p.17 ou le Spécial astuces n°32 p. 20.
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Vous pouvez répéter la session ?

Ipanema Teai (Tahiti) : Existe-t-il un  autre sha-
reware ou freeware remplissant les mêmes fonctions 
que SoundConverter ?

Avosmac : Vous souhaitez faire quoi précisé-
ment ?

Ipanema Teai (Tahiti) : Que croyez-vous que 
l’on fasse avec le shareware SoundConverter ou un 
équivalent, des spaghettis bolognaise ?

Avosmac : Autant le préciser tout de go. Si vous 
estimez que nos demandes de précisions afin de mieux 
vous répondre sont ridicules, mieux vaut ne pas poser 
de question du tout. Avosmac n’a pas vocation à se substituer 
aux hotlines payantes d’Apple et compagnie. Nous offrons nos 
services aux lecteurs (et le sont-ils vraiment ?) et essayons de les 
aider sans contrepartie. Un minimum de patience, de tolérance 
et de compréhension (nous croulons sous les demandes) sont 
requises. 

Faute donc de précisions de sa part, nous invitons cet utilisa-
teur de Mac à se pencher sur la documentation d’iTunes qui sait 
convertir les fichiers audio en de nombreux formats : MP3, AIFF, 
AAC, WAV, etc. Il existe des utilitaires pour convertir le format 
AC3 en AIFF ou WAV comme Bd4go. MPG2Works est capable de 
convertir le format AC3 en AIFF, WAV, MP2, le MP2 en WAV, le 

WAV en MP2, le AIFF en MP2, etc. Bref, tout dépend de 
ce que l’on souhaite faire exactement.

Il est certain que SoundConverter est bien plus 
complet. Cette application payante permet de conver-
tir les fichiers audio entre un très grand nombre de 
différents formats. 

Formats d’entrée :
4xm, 8svx, ac3, aif, aifc, aiff, al, au, auto, avi, avr, 

cdr, cvs, dat, dv, fap, ffm, flac, gsm, h263, h264, hcom, 
ircam, la, lu, m4a, m4v, mat, mat4, mat5, maud, mov, 
mp2, mp3, mpc, mpeg, mpegts, nist, nul, ogg, paf, 
prc, pvf, raw, redir, rm, rtp, rtsp, s16be, s16le, s8, sb, 
scm, sd2, sdp, sf, sffd, shn, sl, smp, snd, sndt, sph, 
svx, sw, swf, txw, u16be, u16le, u8, ub, ul, uw, vms, 

voc, vorbis, vox, w64, wav, wma, wve, xi 
Formats de sortie : 
8svx, aac, ac3, aif, aifc, aiff, al, au, auto, avr, cdr, crc, cvs, 

dat, dv, fap, ffm, flac, gsm, h263, h264, hcom, ircam, la, lu, m4v, 
mat, mat4, mat5, maud, mp2, mp3, mp4,mpeg, mpegts, nist, 
nul, ogg, paf, prc, pvf, raw, rm, rtp, s16be, s16le, s8, sb, sd2, sf, 
shn, sl, smp, snd, sndt, sph, svx, sw, swf, txw, u16be, u16le, u8, 
ub, ul, uw, vcd, vms, vob, voc, vorbis, vox, w64, wav, wve, xi

Les bonnes pâtes

www.mpeg2works.2ya.com
http://denisx.dyndns.org/bd4go/

www.dekorte.com/projects/shareware/SoundConverter/

Économie de rapine
Il est normal de payer un objet, donc 

un logiciel. Conseiller des produits open-
source plutôt que Microsoft, normal. Mais 
encourager les auteurs de shareware pas 

cher et très efficace, c’est tout aussi bien. 
En effet, il me semble que l’économie de 
rapine, c’est pour la face obscure et que 
dans le monde Mac, on paie ses licences 

(on rétribue le travail des auteurs qui nous 
facilitent la vie à bon compte). Philippe C.
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!

ABONNEZ VOUS
PAR CARTE BANCAIRE

depuis notre site internet :
www.magazine-avosmac.com

22 numéros pour 65 euros,
soit 2 ans sans les Hors Série

Nom :
Prénom :
Adresse :

Code Postal :
Ville :
Pays :
E.mail :

Je m’abonne pour …… an(s) à 33 ! (11 numéros)
Je souhaite que les Hors Série soient intégrés à mon abonnement
(pour les abonnés, il est possible de recevoir les Hors-série
sur simple demande par mail (avosmac@avosmac.com) , déduits à chaque parution)

44 ! pour un abonnement de 1 an avec les hors-série (33 ! pour 11 numéros sans les hs)
85 ! pour un abonnement de 2 ans avec les hors-série + CD Open-Source offert (65 ! pour 22 numéros sans les hs)

Je vous envoie un chèque de …… !  à l’ordre d’ AVOSMAC

JE NE VEUX PAS ME CASSER LE BONNET
ET J’OPTE POUR LE PRÉLÈVEMENT AUTOMATIQUE !
Bulletin à compléter et à renvoyer accompagné de votre relevé d’identité bancaire ou postal à :
AVOSMAC - Service Abonnements - La Favrière - 79 250 NUEIL-LES-AUBIERS - FRANCE

       OUI, je souhaite recevoir «AVOSMAC» par prélèvement automatique mensuel (3,20 !)

Nom :
Prénom :
Adresse :

Code Postal :
Ville :
Pays :
E.mail :

Offre valable en France Métropolitaine pour un abonnement postal, interruption sur simple courrier ou mail : avosmac@avosmac.com

TARIFS INTERNATIONAUX
Vente au numéro

Belgique : 4,25 !
Suisse : 6,70 FS

DOM : 3,90 !
Nouvelle-Calédonie : 430 XPF

Polynésie : 450 XPF
Maroc : 36 MAD
Portugal : 4,30 !

Canada : 5,75 CAD
Île-Maurice : 4,60 !

Sénégal, Gabon, Cameroun,
Côte-d’Ivoire : 2800 CFA
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T J’autorise l’établissement teneur de mon compte
à effectuer sur ce dernier les prélèvements
pour mon abonnement au magazine «AVOSMAC». 

N° NATIONAL D’ÉMETTEUR
472361

Organisme créancier : SARL AVOSMAC
La Favrière - 79 250 NUEIL-LES-AUBIERS

TITULAIRE DU COMPTE À DÉBITER

Nom : 
Prénom :
Adresse :
Code Postal:                               Ville :

NOM ET ADRESSE DE L’ÉTABLISSEMENT DU COMPTE À DÉBITER

Adresse :
Code Postal:                               Ville :

Code d’établissement Code Guichet Numéro de Compte Clé RIBIMPORTANT : merci de joindre un relevé d’identité bancaire
ou postal, à votre autorisation.
Il y en a dans votre chèquier.

Date :

Signature :
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